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To add a Calendar Blackout to the CRM Calendar click Calendar → Add →
Property Blackout → Select your date → Start time → Duration 
Hours/minutes → Add your Notes/Reason → Save.
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Calendar Blackouts



Community Dashboard
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Open Batches:
Where you would 
create 
receivable/payable 
batches and open 
find already 
created batches.

Traffic: This shows the prospect 
pipeline  which should be updated 
daily with  all leads. And pending 
application. 

Maintenance: Shows Pending Make Ready, 
Pending Work Orders, and Completed Work 
Orders that need to be followed up on.

The calendar is extremely important  and should 
be looked at daily.  This shows all Move-ins, Move-
outs, and appointments. 

Unit Statistics: This  shows current unit statistics such as 
Leased units, Occupied units and the percentage of both. 
Exposure is showed with Available units 

Resident Activity: Shows Move-In’s, Move-Outs, 
Move-out Deposit Accounting to be completed, 
Units on Notice, Expiring Leases, Scheduled 
Lease Renewals

The Daily Activity Report is 
something that should be looked 
at daily. This will  give an 
overview of the property.

7/29/2024
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Daily Activity Report

The Daily Activity Report shows Resident Exceptions, Month-to-Month Leases, current available 
apartments, Residents on Notice.

Resident Exceptions to be cleared daily. 

Scheduled showings are also listed along with pending move-ins, Move-out Deposit Accounting to be 
completed, and expiring leases. 

Delinquencies current and past, as well as pending work orders are also listed.  
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Once a resident vacates or an application is cancelled, this resident or 
prospect will appear in the deposit accounting field under resident 
activity on the Yardi dashboard:

Deposit Accounting 
in Voyager

To see the residents in deposit accounting, you can click on the number next 
to deposit accounting on the dashboard and a list will populate below:
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Deposit Accounting 
in Voyager

The security deposit will automatically be credited at the 
top of this list and any current unpaid charges on the 
resident ledger will automatically be deducted at the top of 
this list.

Input the forwarding address

In this screen, also input all charges to 
be deducted from the security deposit 
by typing a brief description of each 
charge into the description field next 
to the automated general description 
and typing the monetary amount for 
each charge into the charge amount 
field next to this:

Individual charges will vary by resident and 
property.

In this screen, also input any credits you would 
like to credit back to the deposit by typing a 
brief description of each credit into the 
description field next to the automated general 
description and typing the monetary amount 
for each credit into the credit field next to this:
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Deposit Accounting in Voyager

Once all charges and credits are 
entered, double check that the check 
mark next to each charge or credit item 
is checked:

The charges and credit will not be applied to the 
deposit accounting if the box next to them is 
unchecked. 

Once all charges and credits are entered and 
checked, check the print statement box and click 
post:

Click the print icon to print the 
completed move out statement: 

If changes, such as additional 
charges or credits, need to be made 
to the deposit accounting after the 
above steps have been completed, 
click on the adjust deposit 
accounting link in the resident 
screen under functions on the drop-
down menu on top:

From here additional charges or credits can be entered as in previous steps, with the addition of clicking on 
the box to the right of the charge code field to open a popup to choose a charge code from by checking the 
box next to the desired code and clicking ok

Email PDF to Accountant letting them know it is ready for review. Must be completed within 10 days of move-out or cancelation. 

*Please let the Accountant know whether to mail the refund to their old site address for forwarding or to the 
Leasing Office for pickup.
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Deposit Accounting in Voyager

1. Everyone should be using the FG Walk Sheet. We have set standard charges for 
cleaning and damages are open.  Please note that this must be completed with 
each move out including the top portion and then scanned into Yardi by the time 
the deposit accounting is completed. Additionally, move out photos must be 
taken for any charges that are noted. This will also simplify questions 
accountants may have on charges as they can reference this form when 
reviewing the SODA.

2. With the walk sheet in place, there will be NO Adj Dep Accting changes done 
when bills are received, and charges are slightly higher or lower than estimated. 
We have started charging back based on estimated charges for a number of 
reasons- to avoid having to do additional work in correcting charges that aren’t 
accurate to the dollar as well as an effort to minimize resident frustration when 
we send bills for amounts due several weeks after move out due to invoicing 
delays. This means that at times we will have to absorb additional charges that 
were missed on the walk sheet, but we think it is worth it for the time saved in 
making the adjustments, as well as the customer satisfaction when we send one 
final move out statement within 2-3 weeks of move out. 

3. The only time you will Adjust Deposit Accounting is when a charge was missed 
or underestimated by more than $100. So, if carpet replacement was estimated 
at $500 but really was $700, you can do a 1-time Adjust Dep Accounting for the 
$200 undercharged. This should happen VERY rarely if your walk sheets have 
accurate pricing for each floorplan. Only ONE adjustment is permitted, so if you 
do discover another missed charge of more than $100 on the same dispo, we 
can’t add another charge and send out a third MO Statement as it is just not fair 
to the resident.
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Deposit Accounting in Voyager

4. When entering payables, you should continue to use the chargeback stamp, 
but you will be noting the estimated charge added for this item per the walk 
sheet.

5. Please include the Walk Sheet in all Deposit Accounting emails, and only send 
ONE move out statement per email to your Accountant to review for resident 
move outs. 

6. You can save MO photos to a Word doc and upload to Yardi that way instead of 
messing with a PDF

7. When completing dispos, you might consider using a template via Gmail which 
includes the following info:
Lease fulfilled?
Any special situations with this resident?
Notice vs Eviction vs skip vs transfer
Chargebacks for cleaning/damage added?
Utilities have been confirmed they were in the resident’s name until their MO 
date
All of the following docs uploaded in Yardi for balances due:

i.      Application
ii.      ID
iii.      MI Checklist

iv.      Lease
v.      Vacating Procedures

vi.      MO Photos for any damage

8. Once approved, Accountants will save any Balance Due MO Statements along 
with the Balance Due notice (saved as one PDF) in the Resident Attachments in 
Yardi.
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FCO Collections Interface

From the Resident Screen, click the Collections Interface link in the Data menu:

Click NEW:

Set Collections Status to READY & click SAVE



Page|13

FCO Collections Interface

Then Close the Edit Collections window.

Refresh Collections History window, then click on the ATTACHMENTS link.

Select the attachments that should be uploaded for FCO, then click SAVE.

Documents to Upload to FCO:

Applications

Copy of ID(s)

Vacating Procedures

Move-In/Move-Out checklist

Any Invoices that were charges back

Statement of Deposit Accounting

Lease

That it! Now FCO will grab the info they need from Yardi since the account is 
marked “Ready”. 
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Generating Demand Notices in Voyager
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Navigate from the side menu:  
Reports→ Resident→
Residential Correspondence

Input property, post both month fields to the 
current month, document date to the date of 
the notice, amount owed to the amount of 

the late fee, and select status and current and 
notice, category as resident statement, and 

report type as 3 day notice (days vary by site) , 
and check show on portal, then click display:

Once a list of 
residents generates 
below, click generate 
documents
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Generating Demand Notices in Voyager
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A statement link will generate on the resident list below: 

Click on the statement link next to each resident and a pop up with the 3-day 
notice for that resident will appear:

If you are unsure if you do want to issue a 3-day notice to a resident, you may need to open Yardi 
in a 
second tab (Click “Ctrl” & “N” together) and look at the resident’s ledgers to assess if they do 
require a 3-day notice. 
Click the print icon to print all 3-day notices you will issue to residents. 
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Generating Resident Documents

NOTE : Changes to email 

address and phone number 

MUST be completed by the 

resident via the Portal. 

Updates to CRM and 

Voyager DO NOT sync. 

2. In order to see all the “Report Types” you must clear everything out of the 
“Property” box. 

3. Once the “Property” box is clear, use the drop down next to “Report Type” 
To pick the report you want. Also make sure the “Category” is set to “Resident Statement”. 

4. Fill out any of the other areas you would like to specify the report to draw. 

5. The VERY last step should be to enter the “Property”. 

Once you enter the property, do not click anywhere but on the button “Display”. 

1. Go to Reports -> Resident -> Residential Correspondence



6- Once you hit ‘Display’,  you may have to wait a few minutes for all 
documents to render below . 
7- Once they show and you’re ok with the selections, click the “Attach 
Documents” and the “Show on Portal” 
8- Click ‘Generate Documents’ – this will load all the letters next to the 
residents. 
9-Click on the ‘Statement’ link for each resident to print. 
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Updating Unit Notes 
in Yardi 
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Updating Unit Notes 
in Yardi 
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Updating Unit Notes 
in Yardi 
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Manual Credit Card Payment Policy

• The One-Time Manual Credit Card Payment process should ONLY be used to make a partial payment for a 
resident who has a signed payment arrangement that has been approved by the Manager / Regional.

• All other payments should be made by the resident via their Resident Portal or at an authorized WIPS 
location. We DO NOT accept paper payments.

• All paper payments need a note as we should only be taking these in rare circumstances from residents. 

• One-time manual credit card payments are performed in Voyager and should only be completed by a 
Manager or Assistant Manager.

• The Credit or Debit card the Resident is wanting to use for the payment MUST be added as a Payment 
Method through their Resident Portal. 

• Resident is responsible for all fees associated with using their Credit or Debit Card. These fees are never 
waived. 

• You must obtain a signed copy of the Credit Card Authorization form before processing any payments on the 
resident’s behalf. 

• If the resident signs the form in the Office, you are required to scan a copy and save it to their CRM 
Attachments. 

• If the resident is not able to come into the Office to sign the Credit Card Authorization form, you are 
required to send the resident an email via CRM with the form as an attachment. The resident will be 
required to print, fill out, sign and send back replying to the email from CRM so that the email is linked 
to their resident account. You must then download the signed form and save as an attachment. 



Manual Credit Card Payment
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In order to make a manual credit card payment, the resident MUST have the credit or debit card they are 
wanting to use as a Payment Method in their Resident Portal

The one-time manual CC payment is completed in Voyager. Navigate to the resident’s profile. Click Data and 
then click One-Time CC Payment

Select the Preferred Payment Type of 
Credit or Debit. Then select the card they 
are using from the Existing Cards drop 
down. Enter the Total Amount being paid 
and a Detailed Note regarding the payment 
being made. The Exclude Service Fee? 
Needs to remain selected No as we DO NOT 
waive the Service Fees for making CC 
payments. Confirm all information is correct 
and click Save. 

This will bring up the Credit Card Receipt window. 
Enter the Unit number, Payer and click the Display 
Type dropdown and select Standard Receipt 
Display type. You will not use the Payer Name field 
so do not enter any information in that. Once all 
information is entered, click Enter Detail. 

Once the payment has processed, the screen will update at the 
top indicating the Payment was successfully Authorized and 
provide the Transaction ID, Ctrl Number and Batch Number. Verify 
the payment has hit the ledger and no further action is required. 



· Mid-month Move outs: Please remember not to manually adjust recurring charges for a mid-month 
move-out. Yardi will correct any prorating changes in the Deposit Accounting. If Yardi charges a full month’s 
rent and you manually credit back a portion due to a mid-month MO, you will have to charge back the portion 
you credited after Dep Accting as Yardi will prorate the Credit in Deposit Accounting. 

· Target Lease Expirations: When you are entering the “Lease To Date” on a Prospect Guest Card’s Rental 
Options, please utilize the Lease Expiration Count link (under the Lease To Date) to see how many leases are 
ending around this lease. That way, if there are 25 leases ending in 12 months but only 5 leases ending in 13 
months, you can encourage the resident to sign a 13-month lease, so the Lease Expirations are spread out 
more: 

·

7/29/2024 23

Mid Month Move out &
Target Lease Expirations



Over Budget Warning

• When you click “save” on a payable that is coded to a category 
that is over budget, you will get the popup below on the 
budget tab. 

• You must click “OK” on the Over Budget Warning to save the 
payable.  (Note: if you click “close” on the popup the payable 
will not be saved!) 

• If you do get this warning, please email your regional for 
approval of the invoice which is going over budget when you 
send them the payable batch. 

• Regionals will forward this email chain to the Accountants who 
will then see that the over-budget payables have already been 
approved. 
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Password Change: Voyager 

All new employees should update their password to something secure after their initial login.
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Payables Procedures
Please stamp all invoices with the date received when they arrive

From your Voyager homescreen, click New Payable Batch under the Open Batches section on the right side of the screen. 
You should separate your batches and name it in the description field as “SA utilities or SA Regular and the date entered” 
Enter the total dollar amount of all invoices you will be entering, and the # of invoices, then click Save. 

You will then click the piece of paper with a star on it to enter a new payable.

Refer to the Payable printout for the individual numbered items:

1. Payee- Here you insert the vendor code. You can begin typing the name of the vendor and Yardi will prompt you with 
choices that you can choose from. You can also click the blue link to search for the vendor code by typing one word in 
the vendor’s name in between % signs in the middle search field at the top and clicking the “Find” button:

2. Enter the invoice # listed on the invoice. If none can be found, enter as:
Acct#/date For example: 67920595/101113

3. Enter the invoice’s current due amount. Please note that we can’t pay any Past Due amount and will need to request 
the invoice for any past due charges if they have not yet been paid. To research in Yardi to see if a past due amount has 
been submitted use  the side menu: Analytics→ Financial→ Transaction Registers to search paid Payables. Tran Type 
should be set to Payables, and then you can input as much or as little information as you’d like, including GL account, date 
range and vendor code. 
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Then you can click Ctrl + F to 
search the report for the 
specific account # you are 
looking for, as shown to the 
right:

If the past due amount has 
been paid, please note “paid” 
next to it on the invoice. 



Payables Procedures
4. Enter the invoice date
5. Enter the current month
6. Enter the due date of the invoice. If no due date is listed, enter one month from the invoice date.
7. The Type will default to Invoice. The only time you should change it is when you are entering a credit instead     
of an invoice, in which case you will select the Credit type.
8. In the large notes section you should enter any account # listed
9. Enter the property code to pay for the line item. (If you would like to use a property list to split the payment, 
please click the Distribute button where you can select the property code, enter the amount, add the GL code 
and any line item notes.)
10. Enter the amount 
11. Enter the unit number that the item is being installed in (if applicable) If the item is purchased as stock type 
“stock” in the field
12. Enter the GL code, start typing the description or click the right-side button to browse and select the 
account
13. In the line-item notes please briefly describe the item/service, dates of service & unit # (if applicable). 
Items that need to be assigned to units should be entered on separate lines. If multiple items are being 
recorded on one line enter the number purchased and then description, eg “3 snow shovels”
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1.

2.
3.
4.
5.
6.

7.

8.

9. 10. 11. 12. 13.



Payables Procedures
Utilities

You may have to calculate the billing dates depending on the invoice. For the example below, the invoice shows a
Meter Read Date and # of Days billed. You will then use the Meter Read date as the end date for the billing period and 

subtract the days billed to find the start date for the billing period.

So, the bill dates would be (10-6=4 so) 1/4-1/10
You will also have to fill out a Utility Chargeback 
stamp as follows:

To find the info in Voyager, put the correct property in your home screen and use the Person Search to enter the unit #, 
then find the last resident who moved out by scanning the MO Dates, and then see if there is a current resident by 
scanning the Status line. Calculate a daily rate of any utility by dividing the current due by the # of days billed. 

Charge back any amount over $5 to the past or current resident & send a notice to the resident. 
To charge back from the resident screen, click the Quick Charge link on Functions dropdown menu on the top of the 
resident page and complete as below:
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We will not add utility chargebacks from vendor bills to resident ledgers for any amount under $5 or less than 3 days. 
Any proration calculated to be over $5 owed should be charged back. This will help standardize all sites and ensure we 
are charging back for maximum income, without wasting time on pennies. 

We will chargeback $5 per day coded to 5170 Utility Reimbursement when the incoming, current or vacating resident 
doesn’t put the utility in their name and we have to charge back for usage, except for any invoice that is a FINAL BILL.



Payables Procedures

See the sample invoice and Yardi entry below.
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Payables Procedures

See the sample invoice and Yardi entry below.
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Payables Procedures 
Credit Memos

When we receive credit memos from vendors for items returned, please enter as a positive amount in 
Yardi and change the type to Credit on the upper right side of the payable screen:

When receiving large credit memos please save and enter with other invoices from that vendor to 
offset payment. If a credit has been entered no check payments will result for the vendor until the 
invoices are for more than the credit, at which point a check will be cut. If saving up invoices to use 
on credit let the vendor know. 
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Resident Chargebacks

Carpet cleaning charges for Move-Out’s should be coded to 6908 Carpet Cleaning for the basic clean, 
and 6909 Carpet Repair for any deep clean, red stain removal, seam repair, etc. 
Please use the Resident Chargeback stamp as shown on the invoice below. Any other damage caused by 
the resident should be charged back at Move-Out, including broken window repairs.

Payables Procedures
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Some of the areas you should 
look at when completing charge 
backs are:
• Bedbugs 
• Cleaning 
• Painting
• Lease violation such as not 

picking up after their pet.
• Eviction filing costs



Payables Procedures

Unit Assets/Replacement items tracked in Yardi

The Asset directory should be consulted before 
replacing any appliance or carpet/vinyl in a unit. It 
will let you know if the item is under warranty and 
whether we can chargeback the replacement to the 
past resident due to damages.

Pre-2020 we tracked long-term unit replacements as 
Unit Assets in Yardi. Starting in 2020 we instead utilize 
the Unit Segment field in the payable screen to track, 
and we no longer need to add to the Unit Asset 
Directory. 
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Payables Procedures

Lien Release Reminders

• Any payable(s) requiring a lien release should be entered in a separate batch 
and noted in the batch description. Please also note in the email to your 
accountant to send directly to the office for a lien release. 

• Specify whether your lien release batches totaling over $10k need to be 
mailed via expedited shipping when you send to your Accountant. 

• If multiple invoices are entered for the same vendor that should be cut on 
separate checks, let your Accountant know. 

• If any vendor is being paid over $10k please include Sean, Sarah, Tom, or 
Jane on the email to the Accountant as they need to approve that the check 
can be cut. (Note that this does NOT apply to regular utility batches.)

• Make sure you are using the two forms on pages 35 and 36 to complete your 
lien release form. Send the checklist to the accountant once everything is 
complete. 

General Reminders

* Please don’t submit payables on the last 3 business days of the month, unless 
there is an emergency.

* Batches should be kept to 20 items or less. 

Additional instructions for Utilities, Credit Memos & Resident Chargebacks are 
on the following pages.
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Lien Release
• To prevent a mechanic’s lien from being assessed against the property a lien release form must be signed 

by the vendor performing the work. Note that these liens are usually assessed by contractors for work 
over $2k. If each job is under $2k individually no lien release is required. The Blank form can be found in 
the Server om the following location: D:\Data\SITE SERVER\_ADMIN SITE\_Community Manager\Vendor 
Forms

• Payments for projects over $2k should not be released to the vendor until we have either a Conditional or 
Full release in our possession.

• A blank form can be sent to the vendor for them to fill out, sign and notarize or the vendor can sign in the 
office to sign the release so they can pick up their check at the same time.

• The signed Lien Release form must then saved on the server under Vendors -> Lien Releases

• Under the Lien Releases folder create a sub-folder with the name of the party filing the lien. 

• Save the file titled as lien release with property initials, Lien holder, and date.
• Example: SS Lien Release Jim Bloomer 01-27-15
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Receivables Procedure

Receivables How-To

1. Enter the property
2. Enter the unit #
3. Click on the blue Payer link to view & select the proper resident. Then click the Enter Detail button so all 
outstanding
charges will populate. 

4. Enter the amount of the receipt. 
5. Enter the date the payment was received. Payments should be stamped daily with a Date Received stamp. 
The date on the stamp should be the same as the Date Received entered into Yardi.
6. Enter the check number. If the payment is a money order, begin the check # with “MO” and then use the last 
4 digits of
the money order number. 
7. The Payment Method will default to Check. The only time you will change it is when payment is made with a 
money order, and you will change the Payment Method to Cash. Some residents are only allowed to pay via 
Cash Equivalent, so then payment entered must be a money order & the Payment Method must be changed to 
Cash: 

8. The line item details will auto-populate when you enter the amount, per our settings on which charges to 
pay off first. 
However, if you want to apply the funds in another way you can zero out and/or add any charges to be paid in 
any amount 
up to the total unpaid charge. 
9. For the notes you should only specifying if it is a prepay 

For example: Prepay
If the payee is not the main resident, please note the name of the payee. 

For example: payee Enrique Vasquez
10. Once you have confirmed all information has been entered correctly, click the save button.

Entering a receipt from nonresidents

1. Enter the Property
2. Enter the Payer
3. Click on Enter Detail
4. Enter the amount of the receipt
5. Enter the Account the Income is applied to
6. Follow steps 6, 7, 9 and 10 above. 
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Promote Roommate Procedures

7/29/2024 39

If one of your residents want to move-out and a roommate wants to remain in the unit as resident, you 
can promote the roommate to primary resident when the primary resident moves out.

You can view the scheduled and in-progress promotions on the main dashboard under Resident Activity -> 
Promote Roommate 

To promote a roommate to resident

1. Open the record for the resident whose roommate you want to promote. For more information. See 
Record Searches. The Resident screen will appear. 

2. On the Leasing Actions menu, select Promote Roommate. The Promote Roommate screen appears. 



Promote Roommate Procedures
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3. Complete the screen

Roommate to Promote

Move-Out Date

Reason for Move Out

Agent

Manual Deposit 
Accounting

The roommate to make the primary resident.

CAUTION The Move-Out Date entered for the roommate promotion is not 
checked and validated against any previously entered move-out date for the 
roommate.

NOTE  All roommates for the resident are listed on the look-up list (unless a 
roommate is guarantor, minor, or already has a move-out date, and therefore 
cannot be promoted). 

The notice and move-out date for the current primary resident.

NOTE If the Move-Out Date is set for before today, the current/notice 
resident becomes a past resident, and the roommate selected for promotion 
becomes the current resident. 

NOTE If the Move-Out Date for the resident is set for today or a future date, 
the roommate promotion is scheduled. 

The reason the resident is moving out. 

The agent for the promotion or selected property.

(This field is not editable.)

Determines how the financial data on the moving primary-resident’s record is 
handled upon move-out in the promote roommate procedure. 

• If the field is selected, upon move out date, the system moves out the 
Primary Resident, but you must manually process any open financial 
balances, including deposit accounting. 

• If the field is not selected upon move-out date, the system moves out the 
Primary Resident and automatically transfers any open financial balances 
to the new Primary Resident (promoted roommate) record. 

NOTE  This filed is configured at the system level which requires an optical 
parameter and proper permissions. For more information, contact your 
system administrator. 

4 Click Submit. A confirmation message appears. Click OK to continue.  
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5.  Click Submit to continue. The Custom Data, Roommates, and Rentable Items sections appear. 

6.  For any existing Custom Data, Roommates, or Rentable Items that you want to transfer with the 
roommate that you are promoting to primary resident, select the Transfer button in the corresponding 
row. 

Custom Data

Existing Roommates

Releases the custom data from the primary resident moving out.

Transfer Determines whether the custom data is transferred to the promoted 
roommate.  

Transfer Determines whether an existing roommate is included in the transfer 
to the promoted roommate’s record. 

If the check box is selected, the roommate is moved out from the resident and is 
added to the promoted roommate’s record. 

If the check box is cleared, the roommate is moved out with the resident and is 
not added to the promoted roommate’s record. 
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Rentable Items Releases the rentable item from the primary resident moving out. 

Include Determines whether the rentable item is included in the transfer 
to the promoted roommate.  

7. Click Save

8. When you are ready to post the charges, click Review and Post. The Summary Information screen appears. 

9.  

When ready, click Post Promotion.



Rentable Items

Some sites have parking spots set up in Yardi as Rentable items. To see a list of spots, including which are 
rented and which are available:

CRM→ Search Unit→ Rentable Items→ Assign Rentable Items → Add Rentable Item

You can then select the rentable item that you will assigning type the amount it cost and the lease from date. 
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Unit Segments/Unit Assets
Replacement items tracked in Yardi

Pre-2020 we tracked long-term unit replacements as Unit Assets in Yardi. Starting in 2020 we instead utilize 
the Unit Segment field in the payable screen to track, and we no longer need to add to the Unit Asset 
Directory. 

• For unit segment reporting, you can pull the Transaction Register in Analytics -> Financial -> Transaction 
Registers and specify the unit number to result in all purchases for this unit. You can further refine the 
results by including a period, vendor or GL code as well. This will pull items from 2020 onward.

• Another option is the AP Analytics Expense Distribution report, which you can find in Analytics-
Financial- AP Analytics in our menu. You must specify the unit number for this to show purchases for 
the specified unit within a period. This report separates the expenses for each unit by GL code.
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Unit Segments/Unit Assets

▪ Pre-2020 we tracked long-term unit replacements as Unit 
Assets in Yardi. Starting in 2020 we instead utilize the Unit 
Segment field in the payable screen to track, and we no longer 
need to add to the Unit Asset Directory. 

• The Asset directory should be consulted before replacing any 
appliance or carpet/vinyl in a unit. It will let you know if the 
item is under warranty and whether we can chargeback the 
replacement to the past resident due to damages. 

• A list of all Assets is on the next page.

• To pull info for items replaced in 2019 and prior, There are a 
few ways you can search a unit’s assets navigating from the 
side menu:

•Unit Asset → Review Asset. Then enter the Property code & Unit 
# to see all assets recorded for that unit listed on the side menu

•Unit Asset → Asset Directory Report. Then enter the Property 
Code & Unit # to see a summary of all assets. There are now two 
versions. The original Asset Directory Report is labeled V2. Both 
versions are on the next page. 
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Vendor Setup & Insurance Expiration

7/29/2024 46

➢ Once a vendor has been approved by your Regional Manager for work on your property you will need 
to submit documents to your Accountant to get them set-up in Yardi as a vendor. 

➢ You will need a copy of the current liability insurance and a completed vendor set-up form as shown 
below. Send these to your Accountant and they will set up the vendor in Yardi and provide you with 
the vendor code. Also save the insurance and W-9 to your site server in the location shown below. 

If a vendor does work on-site (installing, cleaning, 
etc) we need to have valid Worker’s Comp 
insurance for them, unless they are a Sole 
Proprietor in which case it is not required. If they 
are a Sole Proprietor with no WC ins who is having 
sub-contractors (friends, brothers, etc) do work on-
site for them, we need them to sign the Indemnity 
Agreement which is found on the server in Site 
Server→Admin→ →Community Manager→ 
Vendor Forms→ Vendor Contract→ FPG Workers 
Compensation Indemnity Agreement. This should 
be forwarded to your Accountant who can save in 
the Vendor’s Yardi setup.
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• If a vendor has expired liability or Workers Comp insurance, we will not be 
able to issue a check.

• To Determine if insurance has expired go to Reports- Vendor -Vendor 
Directory, then enter vendor code.

• You will then hit submit and see the page below. If the dates have 
expired you need to email your Accountant updated copies for each. 



Credit Card Recaps - How to Enter
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• Start by putting all of your receipts in the order shown on 
your Visa / American Express card statement and then 
numbering them in the top right-hand corner in this 
order. 

• Start a payable batch, the description should start 
with VISA, followed by the property and employee 
name(s).

Total will be all credit card statements for your property
-Vendor code for Chase is cachacar.
-Vendor code for American Express is caameexp
Invoice # - last 4 digits of the CC# / last day of CC cycle eg: 1111/122213
Invoice date – use default date
Notes – Last name & last 4 digits of CC# eg: Young 1111
(You will create an invoice for each employee credit card )



Visa Card Recaps - How to Enter

Enter as you would if creating the visa recap / breaking out each part of the invoice to the correct GL.

Notes – Enter the number, dash, and notes with the first word capitalized. 

Ex: “1-Pens, paper, stapler, tape”

You will have to abbreviate your notes as you have limited space.

• Once you have completed your payables, please double check via the batch report. 

• Then send the receipts, scanned and saved separately for each credit card / employee, to your 
regional Manager to review.
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• Finally, please ensure all receipts are scanned and emailed with your Visa recaps to the SF office. Save 
the hard copies for at least 3 months.

Reminders:
• Tipping on all transactions to not exceed 20%.
• Each weekly employee lunch should not exceed 20%.
• Donations are not permitted.
• If the expense isn’t property related, mark on receipt who approved the purchase.
• All gift cards must be updated on the gift card tracking log at time of entering recap.
• Managers are responsible for monitoring all expenses to be kept within budget.
• Receipts must be provided for all transactions. Failure to produce a receipt will result in the card holder 

having to pay for the purchase. If this happens frequently credit card privileges may be revoked.
• Use of the app TurboScan or similar product is highly recommended to avoid any receipts being lost. It 

creates a PDF of the receipt and you can label it with the name of the receipt and the amount. 
• Any reimbursement should be coded to 6318 and the receivable coded the same way to wash the 

expense. MUST be reimbursed same day of entering into Yardi and before it is sent to SF office. 
• All Star and Company gift cards should be purchased on Amazon and only purchased via the Business 

Account only and coded to GL 64070
• Details for any accidental personal charge or missing receipt must be noted in the body of the email 

that is emailed to the SF office. 



Weekly Reports 

Navigate the site server:  
Site Server →Weekly Reports → Year →Month

Open up the most recent Weekly Report

Click File → Save As → Save in current month folder, named with today’s date
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The report is customized for each Community with the respective Community name, Manager’s name, 
Maintenance Supervisor’s name and number of units.   

**ONLY GREEN CELLS WILL BE FILLED IN. BLUE CELLS ARE AUTO-GENERATED**

Cell D2 - Enter the dates of the previous week., Monday through Sunday (10/19/15 – 10/25/16)

First Section- Occupancy Data-
Pull Box Score report- Analytics→Operations→Residential Analytics



Weekly Reports 
• Enter property Code

• Dates will be entered for the current month – first day of month to last day of month (M/1/YYYY-
M/31/YYYY)

• Report type is ‘Box Score Summary’

• Summarize by ‘Property’

• Hit Display

• Under the Availability Section you will find the information for Cells C8, C9, and C11

• Cell C8- Enter Vacant Unrented

• Cell C9- Enter Vacant Rented

• Cell C11- Enter Rented Notice Rented

• For Cells C12 and C13- Click Home in Yardi, then under Unit Statistics, next to Available Units click the 
number of units available
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Monday Report
Weekly Report

Market Survey should be done every Friday or Saturday in the server and saved as every time. On Monday 
weekly reports can be completed and emailed to your reginal that weekly reports are completed. Save as 
every time in the sever name Property Code Weekly Report and the date completed on. Ex: VI Weekly Report 
06-20-2022
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To pull your Budget Variance you will go to Analytics → Financial → Custom Financial → Pull property and 
excel.



Analytic Reports
The most common analytic report you will pull is the Budget Comparison Report. To pull this report you 
will Click on Analytics on the menu on the left-hand side of the screen. Then click Financial -> Financial

This will bring you to the Financial Reports page. Enter property, select Budget Comparison from Report 
Type dropdown menu, and enter the period. Then click Display.

The Budget Comparison Report will allow you to view current Income and Expenses against what was 
Budgeted. Manager should be checking this daily to ensure they will not exceed budgeted expenses. The 
report also shows the budget variance, percent variance, and Year to Date Spending and Budget. 

The Percent Variance will highlight in Red if it is substantially over budget and will remain green if under 
budget. *When entering Payables, if the bill puts the category over budget by 10%you will need to email the 
Regional Manager for approval before the payable can be processed. 
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Budget Variance Report 

You will be responsible for submitting a budget variance report. This will be submitted with your 2nd

Weekly Report of the month (if no overages no explanation will be necessary at that time). Then a 
final one submitted by the end of the month.

Below is how to pull the report and an example. As you will need to get approval on any 
items/services that exceed budget this will help you track, and you should easily know why you are 
over budget. If you are not clear click on the line item in the budget comparison report and click on 
detail- it will list all expenses in that category for the month. Filter screen and report are shown below. 
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Click excel to view the report and enter in notes. 



Pulling Standard Voyager Reports

Financial Reports
Navigate from the side menu:  
Analytics→ Financial→ Financial

Input property, period, and select Report Type, then click Display:

The blue #s in the Analytic reports can be clicked to get more detailed information.

To print, click PDF and then you can print the PDF. Note that the default is to print on legal paper, so you 
may have to change a setting when printing to 
“Shrink Oversized pages” 
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Weekly Reports 
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This will bring up the available units that are not rented. For Cell C12-Unrented Notices- Less than 30 days, 
you are looking for the notices that will be moving out within the next 30 days. (Ex. 1-Unit #1821 since the 
move out date is 9/30/16)

For Cell C13-Unrented Notices- More than 30 Days, you are looking at notices that will be moving out 
within the next 31+ days (Ex. 5- the remaining amount of units moving out)

Cells C15-C17 will automatically populate based on the information input above. These cells should match the 
home screen in Yardi under Unit Statistics for Leased Units, Occupied Units, and Available Units.

For Cells F8 and F9, you will need to pull the Unit Availability Report

Reports→Unit→First Pacific- Unit Availability with Amenities
Enter Property Code
As of Date- Should be current date
Include – Pre-leased



Pulling Standard Voyager Reports

Residential Reports
Navigate from the side menu:  Analytics→ Operations → Residential Analytics

Select Report Type, then input property, date, month/year, and select Summarize By (as necessary) then click 
Display:

To print, click PDF and then you can print the PDF.

Some helpful reports are listed below. Samples are in the following pages.

Financial
• Budget Comparison
• 12 Month Budget
Residential
• Conversion Ratios
• Box Score Summary
• Lease Expirations
• Unit Availability 
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Weekly Reports 
Hit Generate and a new window will pop up with the report

For Cell F8- Input the total count of units that ARE NOT leased and NOT ready- Vacant Unrented Not Ready

For Cell F9- Input the total count of units that ARE leased but NOT ready- Vacant Rented Not Ready 

For this example, all units are ready so ‘0’ is input. Since there is one vacant rented unit that is ready, it is 
showing a 1 in the Ready area (blue). 

Cell G11- Input unit number of the Longest Vacant Unrented Ready unit- Note- put # sign in front of the unit 
number

Cell G12- Input the amount of days the Longest Vacant Unrented Ready unit has been sitting vacant

Cell G13- Input the unit number of the Longest Vacant Unrented Not-ready unit- put # sing in front of the unit 
number

Cell G14- Input the amount of days the Longest Vacant Unrented Not-ready unit has been sitting vacant

Cell C18- Input any specials being offered

Cell C19- Input all marketing for the week

Section should look like this:
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Weekly Reports 
Second Section- Budget Comparison-

Ensure Cell C20 has correct Month typed in

Pull Budget Comparison in Yardi: 

Analytics→Financial→Financial Analytics

• Enter Property  Code

• Book is ‘Cash’

• Report Type is ‘Budget Comparison’

• Period is ‘Current Month MM/YYYY’ to ‘Current Month MM/YYYY’ (Ex. 09/2016 to 09/2016)

Hit Display

Cell C21- Input Total Rental Income Actual

Cell G21- Input Budgeted Total Rental Income (For this example, budgeted is Zero)

Cell C22- Input Net Other Income

Cell G22- Input Budgeted Net Other Income (For this example, budgeted is Zero)

Cell C23 will automatically populate which should equal Total Income on the Budget Comparison report

Cell C24- Input Total Operating Expenses

Cell G24- Input Budgeted Total Operating Expenses (For this example, budgeted is Zero)

7/29/2024 59



Weekly Reports 
Cell C25 will automatically populate which should equal the Net Operating Income on the Budget Comparison 
Report (Income – Expense= NOI)

For Cell C26, click Home in Yardi and then Daily Activity. 

Click on the Delinquency Tab. Enter Total for Property into Cell C26

Section should look like this:

Third Section- Gross Potential Rent-

Ensure Cell C27 has correct Month typed in
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Weekly Reports 
Pull Gross Potential Rent report in Yardi- Analytics→Operations→Residential Analytics

Enter Property Code

Month / Year – must be current month in MM/YYYY format ( Month / Year must be for current month or 
report will not pull correctly)

Report Type is ‘Gross Potential Rent’

Summarized by ‘Property’

Cell C28- Input Total Market Rent

Cell C29- Input Loss/Gain to Lease

Cell C31- Input Vacancy 

Cell C33- Input Total Concessions

Cell C34- Input Total Write Off

Section should look like this:
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Weekly Reports 
Fourth Section- Traffic Month to Date-
Pull Conversion Ratios Report in Yardi- Analytics→Operations→Residential Analytics

• Enter Property Code

• Date is for Current month - first day of month to last day of month (M/1/YYYY-M/31/YYYY)

• Report Type is ‘Conversion Ratios’

• Summarize by ‘Source’

• Hit Display
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Weekly Reports
• Cell G38- Input total number of Calls

• Cell G39- Input total number of Walk-in

• Cell G40- Input total number of Email + Web Leads

• Cell C38- Input total number of Unqualified First Contacts

• Cell C40- Input total number of Shows

• Cell C42- Input total number of Applied

• Cell C43- Input total number of Approved

• Cell C44- Input total number of Cancels

• Cell C45- Input total number of Denials

• Cell G42- Input the highest number listed in the CALL section (for this example, it will be 6)

• Cell E42- Input the Traffic Source with the highest number in CALL section (for this example it will be 
Craigslist)
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• Cell G43- Input the highest number listed in the EMAILS + WEB section (for this example, it will be 26)

• Cell E43- Input the Traffic Source with the highest number in EMAILS + WEB sections (for this example it 
will be Zillow)

• Cell G44- Input the highest number listed in the WALK-IN section (for this example, it will be 2)

• Cell E44- Input the Traffic Source with the highest number in WALK-IN section (for this example it will be 
Craigslist)

• Cell C45- Input total Active Prospects from the Prospect Pipeline on the Home screen in Yardi under the 
Traffic

• Cell C46- Enter total of Craigslist Postings for the week reporting on

Weekly Reports
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Weekly Reports
• For Cells C49, C50, G49 and G50, pull the Resident Activity Detail report in Yardi-

Analytics→Operations→Residential Analytics

• Enter Property Code

• Date is for Current month - first day of month to last day of month (M/1/YYYY-M/31/YYYY)

• Report Type is ‘Resident Activity’

• Summarize By ‘Property’

• Cell C49- Input total number of Move-Ins for the month

• Cell C50- Input total number of Move-Outs for the month

• For Cell G49, you will have to click into the hyperlink number for Move-ins. 

This will bring up a window showing all of the move-ins for the month. 

• Cell G49- Input the total number of move-ins that occurred in the week reporting for (last Monday-
Sunday)
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Weekly Reports
For Cell G50, you will have to click into the hyperlink number for Move-outs.

This will bring up a window showing all of the move-outs for the month. 

Cell G50- Input total of move outs that occurred in the week reporting for (last Monday-Sunday)

Section should look like this:

Fifth Section- Renewals-

Open up renewal worksheet from server- Site Server→Lease Documents→Renewals→Year→Current
spreadsheet

• Cell C52- Total number of Leases expiring for current month

• Cell C53- Total number of renewals of those expiring for current month

• Cell C54- Total number of MTM renewals of those expiring for current month

• Cell C55- Total number of notice to vacate of those expiring for current month

• Cell C56- Total number of skips/no notice/evictions of those expiring for current month

• Cell C57- Total number still unresolved of those expiring

• Cell C58 will automatically populate to show total percentage of successful renewals

• Cell G52 will automatically populate with ‘Yes’ if all number input into C53-C57 equal the amount of C52 
(Total number of leases expiring. Will populate with ‘Error’ if the numbers do not add up. 

• For Cells G54 & G55, will need to go to Daily Activity from Home screen in Yardi.
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Weekly Reports

Cell E54- Input total number of Month to Month residents

For Cell E55, will need to go down to the On Notice Section

Will need to click into the Resident t-code to see if they are MTM. Will need to count total number of 
residents who are on Month to Month AND on notice to vacate. 

• Cell E55 - Input total number of residents who are on notice to vacate that are month to month

• Cell E56 - Input when their rent charges were last updated

• Cell E57 – List the unit numbers that are MTM

Section should look like this:
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Weekly Reports
Sixth Section- Evictions in Process-

From home screen in Yardi, go to Daily Activity and then the On Notice Section

Find residents with Reason for Move out as Eviction

• Cell C60- Input total number of evictions in progress

• Cell D60- Input unit numbers of all residents under eviction

• Cell G60- Input total number of current evictions that were sent over in the current month reporting

• Cell C61- Will need to add up the total balances for all residents under eviction. Best way to find this 
number is by clicking on the t-codes for the residents under eviction and opening up the ledgers. Write 
the number down and add up. 

Section should look like this:

Seventh Section- Maintenance Summary-

• Cell C63- Input total number of outstanding work orders from Home screen in Yardi under maintenance

• Pull Review Service Request Report by going to Service Request→Review Service Request
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Weekly Report

• Enter Property Code

• Work Compl. Dates need to be for the last week reporting (Monday-Sunday)

• All other fields are left blank
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Weekly Reports
Hit Submit. This will bring up a new window that shows the amount of work orders that were closed out 
during that time frame.

• Cell G63- Input total number of work orders completed last week (Monday-Sunday). 

• For Cell C64, Click Home in Yardi and under Maintenance, click Pending Make Ready

A report will come up showing all of the pending make readies. Click on the Date Ready Column to sort it by 
most recent.
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Weekly Reports
• Cell C64- Enter total number of units scheduled to turn this week

• Cell G64- Enter total number of units that were turned last week

Section should look like this:

Eighth Section- Staffing Summary

• C67- List all open positions 

• C68- List where advertising for the open positions

• C69- List who is managing the ads

• C70- List any updates since the last Monday report concerning staff (Ex. Notice given, quit no notice, 
leaves of absence, etc.)

Section should look similar to this. If no open positions, input none on each line. 

Ninth Section- Preventive Maintenance and Projects for the Week

• Enter any projects happening for the current week or what is being worked on at the property

Market Survey Comp/Deposits & Fees/ Amenity Comp Tabs

• Update each tab with the current Market Survey information. Should be updated weekly. 

• .Also copy and paste the latest budget variance report from Yardi if applicable. 
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Weekly Reports
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The green cells in the Market Survey should be updated weekly with the latest specials, rents, and 
fees. Market Survey should be updated with the latest rent prices for our comps. 

As the rents are upgraded the “Price per Square Foot” will be recalculated and will adjust on the graphs 
below. 

*It is very important that the Market Survey is updated every other week  so we know where we stand 
with our competitors for current rents and specials being offered. It should be completed by the 1st and 
3rd Saturday of the month as noted on the task calendar. 

Once everything has been updated and saved the Manager will then email the report to their Regional 

and save it in the Weekly Report folder on the server in the correct Month-Year folder.

• The Manager needs to provide a summary of the information contained in the report. Included in 

this summary is why we are doing great or what we need to improve on and how the current and 

future operations look (good or bad). The summary should demonstrate the Manager understands 

the contents of the report and allow for anyone reading it to get a quick snapshot on how the 

property is performing.



Write-offs 

➢ You will receive a monthly delinquency spreadsheet from your Accountant once they have 
finished completing your properties Tie-Out Report for the month.

➢ You will use this spreadsheet and add notes to the right-hand side for all accounts you have 
sent to collections and are actively working on in-house to collect.

➢ The notes need to be detailed with the date you sent them to collections and the company 
they were sent to.

➢ Try to collect as much money as possible in-house and send past residents to collections after 
90 day of attempts.  

➢ Please highlight the lines that were sent to collections, leave in-house collections un-
highlighted. 

➢ Send this to your Regional by the end of the month so they can write these off for the month. 

➢ No adjustments should be made to a ledger once the balance has been written off. You can 
leave a memo for any errors discovered including the new amount due & notify the collection 
agency, but making changes to correct the ledger after write offs is not possible.

➢ If a tenant has all of their charges written off and then begins making payments, the tenant 
should be charged back for the same amount as we are receiving so that their ledger is at a $0 
balance after posting the receivable. The Manager is responsible for charging back the tenant 
via Quick Charge (NOT adjust deposit accounting) and should always use the Bad Debt 
Recovery (5110) code regardless of what the charges were when they were written off.

➢ The accountant will do all write offs. Please send to them once everything is completed.
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Bad Debt

In an effort to collect more bad debt money in house before sending to FCO, we will offer a one time 25% 
off settlement fee on the FINAL attempt before sending to FCO. There are letters in residential 
correspondence to help in your collection efforts. Here is the timeline for bad debt collections:

• Within 10 days of move out complete deposit accounting

• Accountant will send move out statement with balance owed letter

• 30 days after move out email move out statement and follow up for payment or payment 
arrangement. You can use the attached 30-day letter.

• We allow 6 months to pay off $999 or less and 12 month to pay off $1,000 or greater. You will 
need approval from your Regional if you need an arrangement other than this.

• 60 days after moveout- send another reminder that a balance is owed, and they are at risk of being 
sent to collections

• 75 days after move out send the bad debt settlement. They will have 15 days to pay the settlement 
amount in full

• 83ish days- Accountants will reach out to all Bad Debt one final time before sending to FCO, making 
sure they received the 25% off offer with a reminder they will be sent to collections in 7 days. 

• 90 days – send to FCO

• Please note the above is the minimum contact so please work bad debt as often as possible at time 
permits.

• Please let your Area Manager know if you have any questions or other great ideas of how else to 
collect on bad debt.

To email Bed Debt – 30 Day or Bad Debt Settlement notices from Residential Correspondence make sure 
to enter the Resident’s t-code so that you are only emailing those you specifically want to send to.
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Bookkeeping Reminders/Policy
1. Please ensure you are scanning payable batches in order and with all invoices. They should then be saved to 
the server for your regional to review.

2. On the batch payable screen, be sure Declared=Entered for both the total and # of items.

3. Enter payable batches at least once a week or more as needed. This will help keep the number of invoices 
per batch down and will ensure all bills get paid in a timely manner. Especially important near the end of the 
month when we want to make sure to get all expenses in before the end of the month. 

4. Yardi tracking for resident referral - both who referred and who was referred should be recorded in Yardi. 
Ideally, the referral unit/name should be added to the resident’s Referral concession charge note. If using 
lease charges, add a memo. Attach referral concession sheet to resident’s file.

5. Move Out Policy - you have 10 days to process Deposit Accounting after the resident moves out. This 
should leave plenty of time to get the apartment turned and all chargebacks entered via estimates per the 
Walkthrough. Please check utility bills for chargebacks online. All deposit accounting must be completed 
within the allotted time legally required by state & mailed to the Accountant as soon as it’s ready to be 
reviewed.  

6. Send Ledger for cancels/denials as the Move Out Statements are usually blank. Only need to send if a 
refund is owed or special circumstance. 

7. Please don’t complete any more Deposit Accounting after the 25th until the next month. This will make it 
easier to ensure all refund checks for processed MO’s have been cut before the month ends. You will still 
process the move out after the 25th but hold off on the deposit accounting until the next month.

8. We can no longer refund overpayments for residents. Overpayments are due to resident error and will sit as 
a credit on their ledger until the next charge. Processing refunds takes time in admin processing, and we have 
had numerous situations where the double payment is then cancelled via credit card which takes hours to 
straighten out.

9. Residents are responsible for a $25 check reissue fee for a lost check, or if they failed to update the office 
with their forwarding address. If the resident left an accurate forwarding address and 21 days have passed 
after the check has been cut, FG will put a stop payment on the original check and recut free of charge, 
assuming the check has been lost in the mail.

10. We no NOT accept temporary checks with a handwritten account number.

11. If residents are on a lease that requires 60 days’ notice but will only require 30 days’ notice after going 
MTM, we must charge for the full 60 days’ notice required before their lease is up, even if given only one day 
before lease expiration. Everyone must be consistent with this and all charges so as to be Fair Housing 
compliant.

12. Use the “Move Out Calculator” button, found on the resident screen under Functions, to find out what 
amount will be due at Move Out. 
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Bookkeeping Reminders/Policy
13. After the move-out day you may only hold a home for ____ days and then the new resident needs to 
take possession. If the home is already vacant, then they must take possession within ____ days. By taking 
possession they do not have to physically move-in, however their lease would start this day and they begin 
paying this day. In all other situations the waitlist option should be utilized until a home is available for 
them. Please contact your Regional Manager if you have any questions. 

14. When a resident on an old lease (non-FPG lease) breaks their lease, the Rent through the lease end 
charge should be coded to 5168 Term Fee with the ledger note:

• Lease Termination: charge for rent through lease end

Also, make sure you are coding the fee for not giving 60-day notice to 5164 Notice fee. This should NOT be 
coded to rent

15. In states where residents can still reside in their homes after paying off evictions, we will send a 30-day 
notice after filing a second eviction. 

16. Vendor utility refund checks should be coded as a credit to reduce the expense of the month, rather 
than 5170 Utility Reimbursement, which is used when we charge back utilities to resident ledgers. This was 
the 5170 category will truly show resident utility income on the financials. 

17. No Utility chargebacks should be added to ledgers for: 
• less than 3 days of service or less than $5

or
• less than $5

This is to avoid starting new residents off on the wrong foot by billing back for only a day or two of service. 
For anything over 3 days or $5 we should charge back usage plus a $5.00 daily fee. The $5.00 daily fee 
should be charged if the utility bill is not put in resident’s name at move-in. It should not be charged if 
resident changed the bill out of their name after giving notice or when the bill is a final bill. 

18. Vacant thermostats should be set to 80 in summer and 55 in winter. Walk every vacant unit every 72 
hours to check for burst pipes and squatters. For model, open/close daily to save on heating and AC costs. 
Make sure to send freeze warning notices to residents before the temperature drops or there is a huge 
winter storm.

19. Bonus Program – All bonuses for Star redemptions, extra leasing incentives, etc. will be paid via Amazon 
E-Gift card only and emailed to the email address on record for the employee. All gift cards Amazon E-Gift 
cards must be ordered through the FG Amazon Business Prime Account. VISA, store gift cards, are not 
permitted. All bonuses must be logged on the bonus spreadsheet. 

20. You are required to check Month-To-Month leases every Tuesday to ensure that rents are at market rent 
and all other changes are at current rate.

21. When submitting payable batches that require any Deposit Accounting adjustments for past residents, 
please send the updated Move Out statement to the accountant with the Payable batch so they can review 
at the same time. 
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22. Accountants will send out original and revised SODAs, whether there is a refund or balance due. This 
means you need to make sure to inform your accountant when there is a change to a ledger after Deposit 
Accounting has been completed. Sites are still responsible for trying to collect outstanding balances. 

23. Transfers within the same property will be given a 3-Day “grace period” in which double rent will not be 
charged. Resident may pick up keys to their new unit on Friday with the new unit lease beginning that day 
and return the keys to their old unit on Monday.

24. Charge back 30 days notice as one flat month of rent and 60 days of notice as two months of rent 
instead of calculating the notice fee based on the number of days left in this month + net month’s prorate, 
etc. For example, if a resident gave notice on 2/15 and moved out on 2/20, they gave 5 days notice so you 
can divide their rent by 30 and multiply by 25 days to get the notice fee still due. No need to charge the 8 
days left of Feb + 17 days of March to get the total. 

25. Common area utility spreadsheets should be copied and pasted each month and then overwritten with 
the current month’s info.

26. When emailing your accountant to update market rents at your site, please make sure to include a 
screenshot of the current market rent schedule in the email so everyone is on the same page with what the 
current rents are that need to be increased. 

27. Carpet Vouchers - Upon renewal each home is given a carpet voucher – good for one free carpet 
cleaning within 60 days of receipt. The resident then contacts our carpet cleaning vendor directly to 
schedule the cleaning themselves. At the time the cleaning is done the resident should present the voucher 
to the vendor for payment or leave in plain site in the apartment for the vendor if they aren’t home. The 
vendor should then take the voucher and staple it to the invoice as they submit it for payment. Once the 
invoice is received, the voucher is scanned and attached to the resident profile. Check ‘No’ on the 
chargeback stamp and note “Renewal” on the notes line. 



Chart of Accounts
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Commission Process

• Commissions are due to your regional at the beginning of every month. Check your task calendar to 
find the official date. Your Regional will let you know if they are needed sooner for a particular month. 

• Site manager should review all leasing and renewal files before submitting for commissions to be paid. 
The manger will review the following:

✓ All information in Yardi is entered correctly: name, lease term, lease charges, roommates 
entered, emergency contact entered, renter’s insurance, etc.

✓ Check that lease copy, applications, etc. all correctly signed, completed, and saved in site server 
Move-in inspection sheet completed and saved with move-in photos 

• Commissions will be paid the month after move-in & are paid with second paycheck. Commissions will 
then be paid with the second paycheck of every month. 

• Emergency transfer no transfer fee paid- No commission

• Transfer when lease up- Pay renewal bonus

• Transfer mid lease with transfer fee and extended lease term- no commission paid. 

• Manager discretion to void any commissions if all paperwork and procedures are not followed.

• No commissions paid to past employees if full 2 weeks’ notice is not fulfilled.

• ½ commissions paid to past employees for their leases if full 2 weeks’ notice is fulfilled.

*Commissions vary by site.

• Commission Logs are found in the Accounting folder on your site server in the location shown below.

• Maintenance Team members will be eligible for up to $120 monthly bonus. The percent paid is based 
on the recapture percentage for the renewals. 

• Maintenance Team members will also be eligible for $100 on-call bonus when they’re on-call during the 
weekend.
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Commission Process

• Your commissions log will need to be filled out completely 
as shown in the example below, and all numbers checked 
for accuracy. Check with your Regional Manager for the 
structure for your particular site. 
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Commission Process

Commission Report Instructions

• In CRM Select Reports -> Custom -> Commission Report

• Choose the property

• Enter the dates for Move-in and Lease From for the month you are doing the commission for. Pull for 
Current status only.  

• Click View Report (Top Right Corner)

• Click on the download icon and choose Excel
81



Commission Process

• Once it’s in Excel format review each unit and make sure the following are included in the attachments: 
Lease, ID’s and move-in photos. Please make sure that all attachments should be named for easy review. 

• Once all are reviewed and accurate delete column N (Attachments) Highlight column and click delete in 
top tool bar and choose delete column. 

• Enter the amount of each commission.
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Commission Process

• Once all are entered sort by Agent

• Click on Custom Sort – Choose Column M (Agent)

• You have to highlight the worksheet only to sort by Custom
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Commission Process

• Log into Commission Spreadsheet in the server.

• Copy and paste the info per agent into the worksheet on the server only need to copy Unit Code – Commission 
(Columns B-K)

Complete the top portion and calculations are at the bottom as normal.
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Commission Process
The following checklist should be fully completed and uploaded to CRM to receive each commission. 



Corrective Action 
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• When completing an Employee Corrective Action this form must be filled out by you and signed by 
yourself, the employee you are writing up and a witness. 

Best Practices:
• Make sure you have email documentation to back up your responses
• Make notes of dates and times where you have previously spoken to the employee about the subject
• Refer back to the Employee Handbook with a certain policy that was missed and resulted in this 

corrective action
• Reiterate the policy that must be enforced and some tangible goals to reach in the Performance 

Improvement Plan
• Finish off Performance Improvement Plan with “Any violation of company policy or instruction can 

result in further corrective actions up to and including termination.”



Daily Task List

• Every morning you will send out a daily tasks email. This email will consist of tasks that need to be 
completed for the day and reminders and announcements such as: scheduled appointments and tours, 
inspections, move-ins, move-outs, etc. 

• The daily task email will summarize the CRM calendar, property calendar and daily task calendar for each 
day. 

• You should list out specific tasks assigned to each team member and are required to include a quote or 
meme to motivate your team. 
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Happy Thursday team!

So excited to have Aaliyah here today!! The toilet project is 
starting to wrap up and so is the week. We have 2 turns to wrap 
up and 1 to start! I know the turn are keeping us busy, but we 
really need to knock some WO out too! Lets lease these 
apartments, collect some $$ and have a great day!!

Mckenna
Send pest notices for 1-305,1-306,1-205,1-206
Walk 5-301 Make Ready @ 4:30 PM
Managers meeting 3-4 PM
Review NTV's
Work applications with Aaliyah-Luis, Gomez need to be 
submitted
Send MTM letter to 4-208
Delinquency-door knock those filed on

Aaliyah
Clear queue/follow ups
12 PM Appointment with Lori
Work applications with Mckenna-Luis, Gomez need to be 
submitted
Door hangers for July renewals

Maintenance
Wrap up 5-301 turn & walk with Mckenna @4:30
Start 8-304 Turn
Wrap up 2-202 turn, this is MR for tomorrow
Grounds
26 pending WO-there are a few I will close out this morning, but 
we need to get these down!

Hi Team,

It’s another rainy day in Ohio, you know what that 
means…RAINBOWS!

Amanda
• Opening Procedures
• Work Order Follow Ups
• Work Queue
• Walk Make Readies with Marcus

Marcus
• Application Updates
• Facebook Posts
• Work Queue
• Walk Make Readies

• 21-7282B
• 03-2687S
• 06-2625S
• 08-7215B

Amber
• Small Balances – Call/Text and Send Notices
• May Renewals – Call Pending for May
• Deposit Accounting
• Walk 30-2501L MO



Employee Files

• All information regarding current and past employees is confidential and should be kept secure at all 
times.

• Save all employee related information and forms (ex: new hire paperwork, PTO requests, reviews) in 
your secure HR server folder and to the employee’s file in Prism

• Move past employees to the past employee file as employees are termed. Follow up with your regional 
if you don’t have access to this.

To add document to Prism profile: 

• Select Employee from ‘My Employees” list

• On employee page click the 3 lines in the top right corner

• Select Documents from the list

• Then select Load a document
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Employee Review: 90 Day

• 90 Day reviews are mandatory and must be part of every employee file.

• It is the manager’s responsibility to put a reminder on their calendar the day the new 
employee starts so it’s not forgotten. 

• Enter all info in the top as you would for an annual review. 

• Be conversational and get feedback on how the team member is feeling and find ways we 
can help them succeed in their positon. 

• The 90-day review is designed to ensure the team member is meetings the job 
requirements and if not, provides a formal setting to address their performance issues.

• It also provides a forum for the employee to ask any questions they may have or voice 
any concerns.  
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Employee Review: Annual
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• Employee reviews are due annually within a week of an employee's work 
anniversary.

• Complete reviews at least 2 weeks in advance to have your area/regional look 
over them.

• Please be sure to fill out the top section of page 1 and then all highlighted 
areas. 

• Remember to give tangible goals for the team member to reach, for 
example, Increasing revenue by 6% by next review, 1 positive google 
review a month, taking 1 leadership course a month.

• Once your area/regional returns the reviews to you, schedule a time with the 
employee to go over their review.

• Please use the specific 90-day review form for the team member’s 90-day 
review. 



Evictions 
• Evictions should be filed with your attorney per the collections policy in your lease. (Generally, the 

20th of the month)

• After filing a second eviction on a resident, we send a 30-day notice for them to vacate, except in CA. 

• The section shown below should be included in your lease to outline this policy.

Follow the below Delinquency Guide to collect delinquency and prevent evictions

• Cover the lease at the time of move-in and clearly outline the payment process and importance of paying 
on time is vital to training the residents to make their rent payment their #1 priority. 

• It is important that you make constant contact with the residents when they are late on rent.  Here is the 
basics for contact (always go above and beyond this).

• Follow the Monthly Task Calendar for specific deadlines as they do fluctuate every month

• Serve your notice of Non-payment timely.   If rent is late on the 4th the Non-payment notice needs to be 
served on the 4th unless it is a Sunday.  Anyone that owes over $100 should be served a notice of non-
payment.

• Always require payment in full to avoid chasing small balances.
• If there is a balance under $100 – send balance reminder on the 7th.
• Send again every 4 days until paid

• Make contact with all delinquent residents on the 7th. Get them to commit to paying no later than the 
15th. Remind them every day their balance is increasing (for sites with daily late fees).

• If not contact by the 12th serve a 24-hour notice of entry to check for occupancy. 

• You will make contact ever other day with delinquent residents until you have a firm date of payment. 
Use all sources: call, text, email and knock-on doors. 

• Update your delinquency report daily. Submit to your regional no less than twice a week (Monday & 
Thursday).

• 24 hours before promise to pay, contact the resident to remind them to pay and give the total that will be 
due and then again, the morning of. 
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Evictions 
• The day before filing evictions you must knock on doors for anyone that has not paid and try to 

collect ASAP. Remind them of costs to file and the eviction process. Serve NASTY GRAM – has notice 
of entry stated on the form. If no answer – check for occupancy.

• Evictions are to be filed no later than the 20th of the month bust must be filed on the date indicated 
on the monthly task calendar. There are no exceptions to this rule. Only Sarah Young or Jane Gray can 
give an extension on filing evictions. Once filed, place them on evictions and charge the legal fees. 
Once they are put on eviction they will be locked from the portal so they must contact you to make 
payment. Instructions for placing on eviction are below.

• After filing you will reach out every 3 days prior to court to try and collect full payment. If no 
communication, you will need to serve notice and check for occupancy every 3 days until contact is 
made. If not paid by court, serve 24 hour notice to check for occupancy the day after court ad then 
serve every 3 days until they are out or put out by the bailiff. 

Example Delinquency Report

Eviction Process

• Once the file is sent to the attorney the Manager / Assistant Manager will enter the eviction into CRM and 
charge the attorney’s fees/. You will enter the eviction date as 12/31/99 as this will put the unit on notice 
and we don’t want it to get leased as many pay to stay. 

• If they pay you will then take them off eviction. 
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Evictions 
• This will take some monitoring so please make sure you look at the move-out date before offering a unit 

to lease. 

To Place on Eviction in Yardi:

• From the resident screen choose Actions and then click Evict

• Enter the move-out date of 12/31/2099. Click Save. DO NOT post the term fee as this will only be charged 
if they move out. 

• If they pay you can Cancel Evict under Actions

• If they NO NOT pay then you will go under actions to adjust the move out date once we know we will get 
possession of the unit. 
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First Republic Check Scanning
Using the provided website login with your new 
username and password:

Enter “First Pacific Group” in the entity name and your 
unique login name and password, then click sign in. 
Your login name should be your first initial and last 
name.

You may get an error message. 
Click the hyperlink “Click 
here to reload 
this page” to 
get to the 
website. 

There is a Training module in the Toolbar for you to 
test out the checkscanning process to familiarize 
yourself with the steps:

To scan in checks for 
deposit 
go to Capture →
Create/Edit 
Deposit or click the 
Merchant Deposit link:
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First Republic Check Scanning
Select the date, Location, Account to deposit the checks to, input total Deposit amount and click on Create New 
Deposit:

This will generate a Deposit Ticket which contains the inputted/selected information. Place checks in scanner 
(light should turn from green to orange on scanner). Click on Scan. 
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First Republic Check Scanning

Check that the light on the scanner turns 
orange once the checks are inserted:
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Checks must be divided by property and 
can only be scanned and deposited to 
one property at a time. Check that the 
light on the scanner is green:

Insert the checks into the scanner 
facing outwards:

If there are any issues there will be highlighted lines in Yellow 
to click and correct.

To navigate:

Make the necessary adjustments to the transaction as needed.

Step Action
1 Press the Enter key on the keyboard for each item viewed.
2 Use “Flip” to view the back image and to return to the front image.
3 Use the tool bar at the top right to adjust the view of  the image.
4 Continue to press the Enter key on the keyboard until all items are 

reviewed.



First Republic Check Scanning
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CORRECTING DEPOSIT AMOUNTS

Enter the correct value for the highlighted fields using the image displayed.  Include the cents value; the 
decimal point is not needed. The system automatically marks the last two values as cents.

DELETING ITEMS

Items may need to be deleted from the transaction.  This could include items with incomplete information.  
Follow these steps to delete items:

DELETING DUPLICATES

To delete a duplicate follow the steps above. 

If “Possible Duplicate Item Review” is shown, compare the two images or item details to determine if the 
item is a duplicate.

Physically remove the item from the scanner.

Step Action
1 Highlight appropriate item.
2 Click Delete.
3 Click Yes to confirm deletion.

If Then Result
If the item is not a 
duplicate,

Click No. The item remains in the 

transaction, but will be 

flagged for central 

processing to review further.
If the item is a 
duplicate,

Click Yes. Then click Yes

to confirm deletion.

The image data is 

permanently removed from 

the transaction. This effects 

the transaction balance, 

which may require a final 

review of each item.



First Republic Check Scanning
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IMAGE QUALITY AND USABILITY

If an item fails an Image Quality test, a message displays in the capture screen indicating the failed test. The 
options available for modifying the image depend on site configurations and type of error.

The captured images display in a preview window with list of detected errors.

In some cases, rescanning the item is not an option and it must be removed from the transaction.

If unable to capture a good image, and the option is provided, click Ignore to ignore the image quality 
warning and continue processing with the poor quality image.

FINAL BALANCE

When all the deposit items have been captured and corrected, the transaction may need to be balanced if 
the deposit amount has changed. 

If there are no issues it will show the remaining as 0.00 and Deposit is balance and ready to be closed in 
green: (see next page)

Step Action
1 Review the message for recommended action. 
2 To rescan the image place the physical item back in the scanner.
3 Click Rescan.

NOTE: Once the rescanned image displays and quality errors are 

updated, the brightness may also be adjusted with the image 

brightness slides. This can only be done after an item is rescanned.
4 Click Apply to update the error messages and recaptured images.
5 Click OK to return to the capture screen.

Step Action
1 With the item selected, click Delete.
2 Click Yes to confirm the item should be deleted from the transaction.
3 Remove the physical item from the transaction.

Step Action
1 Press Enter on the keyboard after reviewing each item.
2 Select “Use the scanned amount”.



First Republic Check Scanning
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Check that routing, account and amount numbers are correct. 
When deposit is balanced and read to be closed, click Close.  



First Republic Check Scanning

It will give you 3 options:

Select Release when the deposit is correct and okay to process.

Now it will have your deposit batch highlighted in blue. Select Transmit 

Selected Deposit if it is correct and okay to process to the bank:

It will show the highlighted when deposit has been transmitted successfully, Status will go from Released to 
Acknowledged. 

Click the PDF icon to print a report. 
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First Republic Check Scanning

Please take a screenshot of this to email to your Accountant as deposit confirmation as checkscan will no 
longer email you the confirmation.

The cutoff for deposits is 6:00PM PST

If you need to delete the entire transaction please note:

A transaction can only be deleted if it has not yet been transmitted to the central site.  

DEFERRING BATCHES

If you need to leave the application prior to closing the transaction or want to save the batch to add more 
checks to it later:

The transaction is listed in the main capture screen as an Existing Deposit. 

If you are in the middle of capturing a deposit and you experience a power outage or lose internet 
connectivity, the system will automatically defer the deposit.

HOW TO COMPLETE A DEFERRED TRANSACTION

Follow these steps to complete a transaction you have deferred or a transaction that has been deferred 
because of a power outage or internet connectivity issue. 
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Step Action
1 In the main capture screen, highlight the transaction to complete.
2 Click Edit Deposit.
3 Complete the transaction in the capture screen.
4 Release the transaction for transmission.



First Republic Check Scanning
If you ever need to pull up the deposit confirmation again or research previous deposits, you can go to 
Analytics → Reports:

Select Deposit Reports then click Deposit Detail. Enter a start and end date, select the location and an 
account(s) and click Generate Report:

7/29/2024 102



First Republic Check Scanning
Click the Print and/or Download icons.

Deposit Summary will show you the deposits that were processed for the chosen account:

Deposit Details will show each specific check:
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First Republic Check Scanning
You can also search for specific checks by going to Research:

Input search parameters.

Example: Search by “Check amount”.  Enter Start and End dates, Location, and Amount equal information. 
Click Search and it will bring up the results.
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First Republic Check Scanning
Click on the line to get to the check image.

Check image scans are available on the website for 60 days from the date they are scanned in.

For setting up users and access/permissions changes contact your Regional Manager

For troubleshooting related to computer settings please call First Republic’s help line at 800-221-9777, 
option 1   (Hours of Operation: Monday through Friday, 6:00AM PST until 5:30PM PST).

When you have a receivable that is unable to be scanned into First Republic & needs to be mailed to the bank, 
please scan and save a copy in the resident’s attachments in Yardi in case the original is lost in the mail.

This check or Money Order should be entered as a separate receivable batch. Send the check to the bank with 
the self addressed stamped envelope and write “For Deposit Only” and the account number on the back.
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Elearning – First Pacific University
Reporting

• To track you teams progress click Visit Group Supervisor – Reporting Mode

• Then click the Reports Tab to bring up the screen below. Use the filters provided to refine your report

1. Report Type

2. Date Range

3. Property, Job Title, etc. 
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Elearning – First Pacific University
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• The report will then display beneath the filters



Elearning – First Pacific University

Assigning Courses

• Click the Users tab at the top of the page.

• Search as needed to find the team member being assigned a course, then click Edit to the right of their 
name.

• On the users page, navigate to the Course Tab 
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Elearning – First Pacific University

• Click Add 

• Search for the course you’d like to assign in the search bar, then click Assign
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Elearning – First Pacific Group

• To modify the due date once assigned, click the 3 dots next to the info box and 
select edit due dates. Enter the new due date for the course.
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General Reminders / Policy
1. Lease Signing Workflow 

• 6 Days from Move-in: Leasing team sends email asking for utility confirmation numbers, confirming 
their move-in date & charges, and asking if anything needs to be changed or added, like a pet or 
parking, etc.

• 4 Days from Move-in: Phone call to obtain confirmation numbers if not yet received and request all 
pet documentation be received. Let resident know they will be receiving the lease agreement to 
sign and once countersigned they will be able to log into the portal to pay their move-in fees. 

• 3 Days from Move-in: Manager generates and finalizes the lease to send to the resident to sign.

• 2 Days from Move-in: No more than 2 days before move-in, the manager countersigns the lease. 
Leasing calls/emails to let the resident know the lease has been countersigned and they need to log 
in to make their payment prior to picking up keys. Set appointment to pick up keys.

2. Application Approvals – Ruanne reviews all applications for all sites. Jane reviews criminal for all sites. 

3. Transfer Policy – Unit transfer system function in CRM will only be used when ALL residents from one unit 
are ALL transferring to a new unit on the same property. If any resident from the old unit are leaving or any 
residents are being added to the new unit, the Transfer Function in CRM will NOT be utilized. If old residents 
are leaving or new ones being added on, they will all go through the Online Application process to register and 
reserve the new unit and will be auto screened to qualify for the new unit. Even though we are making them 
register like new, does not mean we cannot still use the ‘transfer’ verbiage and our ‘transfer’ policy when 
talking with the resident. 

4. Service Animals – Will be tracked via memos in the resident data. Select Service Animal as the type. Enter 
the animal that was approved and the date. This should only be once the Reasonable Accommodation is 
approved by the Regional. Enter all that you are knowledgeable about now and add upon renewal going 
forward. 

5. Lock Out Policy – In an effort to assure we are acquiring identifying information from anyone who has been 
locked out of their apartment a Resident Directory will be emailed to the Manager and Maintenance 
Supervisor EVERY Friday.  The report must be printed by 3pm on Friday and placed on a clip board by the key 
box.  If On Call Maintenance is called out for a lock out, they are to check the report FIRST to assure the 
person wanting access is a Resident with legal access. The On Call person will check the ID of the caller.  The 
ID # must be written on the attached form with the rest of the required info in the box in the left-hand corner.  
Please note that most properties are charging $50 but the attached form needs to be updated if your property 
charges more. This Lock Out form should be left on the clip board with the resident info, so the manager call 
apply the charge the next day

6. HR Communication - Only regionals will contact HR (MidwestHR).  Managers will bring any issues to 
Regionals attention and not be copied in the correspondence with MidwestHR.  Regionals will inform 
Managers once the issue is resolved.
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General Reminders / Policy
7. Cancelling a NTV - Effective immediately, when a resident wishes to cancel their Notice to Vacate, you will 
need to regenerate the NTV form from their resident account and delete out all information with exception of 
the following:

1.Date- Enter the current day's date
2.Reason For Moving- Click the drop-down menu and select 'Rescind NTV'
3.Community Suggestions- Enter 'Resident is cancelling their notice to vacate'
4.Click Save.

You will then Preview and regenerate and finalize the Notice to Vacate form in Online Documents which will 
email the resident (s) to sign that they are cancelling their notice. Once all residents have signed, you will 
countersign and cancel their notice via the Leasing Actions button. 

8. Criminal Denial Policy - Updated criminal denial: 

(c)  Management can deny any applicant whose tenancy would reasonable be expected to have 
a detrimental effect on other tenants, the environment of the community, or where an 
applicant’s history would evidence an inability to comply with the lease terms or a likelihood of 
interfering with the management staff.
(d) Anyone having been convicted of a felony offense against persons and/or property or 
involving controlled substances or deadly weapons.  This is included but not limited to 
conviction of distribution or manufacturing of a controlled substance, physical violence, 
destruction of property, sex offenses and criminal activity that would adversely affect the 
health, safety or well-being of other residents or cause damage to the apartment community.
(e) Anyone currently under Parole or Probation Supervision.

9. Last Minute Renewals - For any pending renewals in the ‘Selected’ status that are due to expire, the 
Renewal Lease proposal should be Cancelled later than 5pm on the day the lease expires. This is done by 
clicking on Scheduled Renewals and clicking the cancel button next to the resident. Create a calendar 
reminder on the day leases are due to expire at your property to check for expiring leases that have not 
signed the renewal. This will remove the option to ‘Sign’ the document in the Resident’s Portal. Resident will 
automatically roll Month-to-Month the following day. If they decide that they want to renew, create a new 
proposal for the 1st of the following month and approve it. The resident can then Select the proposal and a 
new renewal lease can be generated and finalized. If this process is not followed, we should NEVER counter-
sign a Renewal Lease for a resident who has rolled Month-to-Month.

10. Leader of the Day - Leader of the day (office) Each day a new team member will be leader of the day for 
the office staff.  The leader will assure the daily task list is being completed and confirm with all if any 
assistance is needed to stay on track.  The team member will set an intention for the day such as a goal or 
quote.  This will allow each team member to learn to lead and to know they have a voice as part of the team.

11. Maintenance Huddles - In order for all of Maintenance to know what the priorities of the day are each 
team will hold a DAILY Maintenance Huddle.  In this huddle work order, turns and any projects for the day 
should be discussed.  Work orders should be assigned and Make ready checklist provided for the units that 
will be turned.  Each meeting should only take approximately 15 minutes.  This huddle will also allow any 
questions to be answered first thing in the morning and to make sure no emergencies occurred over night.  
There will be a different team member who leads the huddle each morning but, the maintenance supervisor 
will provide the information.  This will allow all to become comfortable leading a team and knowing they have 
a voice as part of the team. 
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General Reminders / Policy
12. Make Ready Dates - Make ready dates will not default beyond 7 days.  OH & MI set to 5 days effective 
8/23/19.  All sites to have the following policy as a "safety net" : ONLY managers cancel applications and 
correct make ready dates. Ruanne to review make ready dates before denying an application and then will 
adjust after it is denied

13. Applications Valid for 75 Days - Please note the highlighted area in which we are allowing an application to 
be valid for 75 days from the date of application.  If they lease a unit outside the 75-day window they will be 
required to provide current proof of income on the 60th day and criminal and eviction check will be re-run to 
assure no issues have popped up. 

14. Income Criteria –

1). One month's worth of paystubs is the required method of verifying income. If you do not 
have your last month's paystubs, we will require written employment verification and the 
past 2 months of bank statements.

2) Add to criteria, applicant is required to provide confirmation proof of utilities in their name 
prior to move in. If utility debt is in their name, either confirmation of pay off or confirmation 
number is required.

15. Remove Roommate – Manager / Assistant Manager should complete the process

• All Remaining leaseholders must submit their 2 most recent paystubs to confirm they qualify.

o All leaseholders must have been screened through Fp. If they have not, they must be screened

o If a guarantor is being removed. Screening must be run on the remaining residents – if additional 
deposit is required, must be paid prior to guarantor being removed. 

• Once all paystubs have been received and any screening required is completed, send to Ruanne to 
approve the removal of the roommate. 

• Once approved by Ruanne, generate the Roommate Rider.

o If the primary resident is the one leaving, you must first complete the roommate rider to remove 
them. Once signed by all leaseholders and countersigned, you can then use the Promote 
Roommate function. 

o If roommate is leaving, you can use the roommate rider as instructed. 

7/29/2024 113



7/29/2024 114

Incident Report 

• Incident Reports should be completed within 24 hours for items such as trip and falls, 
fires, deaths, etc.

• When completing an Incident Report, you should always include a completed form, 
pictures, and a witness statement when applicable.  

• This form should be saved to the server and emailed to your Regional. 
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IT Support Template

In an attempt to expedite any technical issues and to minimize the back and forth required to help 
troubleshoot, we have created a template to utilize when emailing an issue or request. 

The template below is required to be used for each request submitted. Please copy and paste it into the body 
of your email and fill in the responses to each item with as mush detail as possible send nbuttner@fpacific.com

IT Support Template

Property:

Issue:

FGPC#:

User(s) Affected:

Did you restart your PC?

Did you apply all pending system updates? (Start -> Settings -> Update & Security -> Check for Updates)

Troubleshooting steps already attempted?

Screen Shots:



Manager’s End of the Month Checklist

By noon on the last business day of the month, please ensure each of the following has been completed:

1.    All deposit accounting has been completed
2.    Resolve all outstanding balances
3.    All receivables have been entered
4.    All payables have been entered
5.    Timecards & OT Logs are up-to-date
6. Confirm all prepays are correct & notify residents
7. Bad Debt sent to collections
8. Expiring vendor insurance is up to date
9. Review Expiring ACH payments
10. Monthly Training Completed
11. Safety Meeting completed
12. Evictions filed

An e-mail will be sent to you to confirm these items.
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Mileage Reimbursement
Please check with your Regional Manager to see what the guidelines are for your property. These 
are to be submitted one time monthly at the end of the month and include all mileage for that 
month. Destination section should include detailed notes for where the employee was traveling 
to and the Apt. number they serviced. 

Lowe’s/HD runs need manager approval and are for emergencies only. Supplies should be 
ordered for delivery next day whenever possible to save time and avoid paying mileage.  
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Newsletters

• Each quarter you will submit the information for your community newsletter. Each site has it’s own 
newsletter featuring community announcements and reminders, resident giveaways and events, a 
calendar of important dates, and events going on in the area.

• You will submit this info via the FG Marketing Order System. The link is found on the Employee 
Resources webpage. 

• If you need inspiration you can view past newsletters by clicking the view example link
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Newsletters
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• Once all info is entered on the worksheet and checked click the ‘Submit Newsletter’ button at the 
bottom to send to the marketing department for creation. You and your Regional will receive a copy 
of the info submitted to the Marketing department as confirmation it transmitted successfully.  

*BE SURE TO DOUBLE CHECK ALL GRAMMAR AND SPELLING PRIOR TO SUBMITTING*



NSF Procedures

• If an ACH payment NSF’s you’ll be notified by your Accountant, you should then 

chargeback (as applicable) and late fee (for properties whose late fees aren’t 

auto-posted.)

• On the resident ledger you will then see:

• Please contact the resident about their current balance due as shown at 
the bottom of their ledger. 

• Some sites don’t charge late fees if the NSF is repaid within 24 hours of 
notifying the resident. In this case, please reverse the late fees when 
entering the repayment receipt.

• Most sites only allow 2 NSFs before requiring a resident only pays using 
a cash equivalent.
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Star Program

• The star program allows team members to recognize colleagues who go above and beyond by giving 
shout outs. 

• Shouts are now submitted on our home page. 

• Managers are given a quarterly amount to spend on employees each quarter. You can reward them with: 
Special lunch, coffee’s, amazon gift cards, donuts, breakfast, t-shirts, etc. 

• On our homepage click the shout out button then this screen will pop fill out the info then click submit. 
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PTO Request Process 
• All PTO requests should be made through the Employee Portal. 

• Once logged in, click Request Time Off in the Paid Time Off Section on their dashboard. 

• Select PTO 40hours for regular full time employees from the PTO type dropdown and enter Dates, Hours 
and Comments. Then click submit.

• You will then receive an email to approve the PTO request. If it is approved by your regional please add it 
to your site’s HR/PTO calendar that you share with your regional. 
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Reviewing Payroll in Time Clocks Plus 
• Use the Employee Resources link to login to Midwest HR Manager

• Click on My Payrolls on the top and then Time & Labor

• You will be taken to your Time Clocks Plus dashboard which shows a quick overview of items that may 
need your attention such as Required Approvals, Missed Punches, and Overtime logged.

• To review punches, you can click on Hours on the top menu and then review Individual Hours or Group 
Hours for your employees

• Note that you can review hours by updating the start date and stop date manually, or by selecting a 
period from the dropdown, such as This Week, This Period, or Last Period and clicking the Update 
button.
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• If you need to edit a punch, select the row and click the Manage button (or hover over the row you want 
to edit and right click to see your options) where you can click Edit, Delete or Add break.

• To Edit, you will get a popup window where you can change the date in/out & time in/out. You can also 
indicate if you are updating due to a missed punch, and whether the person is currently clocked in with 
the check boxes on the left. If this shift may result in payroll add a note indicating what the approved OT 
was. After adjusting click SAVE

7/29/2024 124

Reviewing Payroll in Time Clocks Plus 



Reviewing Payroll in Time Clocks Plus 

• To add a missed break, you will enter the start time and length on the popup and click Save:

• To Add a shift, click the Add button where it will bring up a popup exactly like the Edit Segment popup, 
where you can fill in all info about the missing shift. Only the available options for that specific employee 
will show in the dropdown list: 
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Reviewing Payroll in Time Clocks Plus 

• In Group Hours you can select a period to show all employees’ punches for the period. 
You can edit here as well!

• For Regionals who want to view only one property’s hours at a time: click the Employee 
Filter button and go to Employee Role, where you will select both hourly and salaried 
employees at one site to see everyone.

• When you have reviewed the hours for an employee and they are correct, you have to 
Approve them in the system. You can do this in Individual Hours or all at once in Group 
Hours. Pay special attention to any PTO taken each period, and make sure it has been 
entered correctly!

• Before submitting payroll, all employees will need to approve their own time one of two ways: 

• Signing printed timecards (as we have done in the past) 

• Via the TCP employee approval boxes per the instructions below:

• Employees will log into the time clock the same way they would Clock in, and selecting Log on 
to Dashboard
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Reviewing Payroll in Time Clocks Plus 
• Then View → Hours

• Navigate to different weeks:

• And select all checkboxes to approve all hours submitted. Employees can select the top box with the E ✓
to approve all of their hours in the period. This will take the place of employees signing timecards for the 
period.

• It’s ok if some employees approve online and others sign the report, as long as everyone approves each 
payroll that is submitted by the Tuesday of payroll week. 

To review hours for termed employees 

• From Individual Hours, you can use the Employee Filter to included terminated individuals- Take away 
that check mark for Employee Status and hit Filter, then you can find them in the list:
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Reviewing Payroll in Time Clocks Plus 

• Reports

• Navigate to Reports → Period Reports

• The reports in the Payroll & Job Code categories will be most useful to review. Complete Payroll shows 
each employee’s punches each day, weekly totals, and a summary of Regular/OT/PTO hours. Feel free to 
browse around and see which other reports you find useful.

• You will select the Payroll category, and the Complete Payroll report, then change the Period to This 
Period (either by typing it in the field or selecting it from the dropdown) and click the Preview button to 
generate. You will get a popup while it generates but it should be very quick, and then you can select the 
Preview button to see the report. Once you have approved all payroll, this is the report you can print for 
employees to sign and save on the server.

• Another useful report is under the category Job Code → Job Code Group Detail. Again, change 
the period and click Preview to see a more condensed version of all hours logged. 
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Reviewing Payroll in Time Clocks Plus 

• Job Code Group Summary is even more condensed, just showing totals for the period:

Recommended Settings for Managers in TCP

All of the items below can be found if you navigate to Hours→ Individual Hours and click the Options 
button:

• Display section under Worked Hours, this will show actual times in addition to rounded times 
for all employees- you may or may not want this enabled- your call!

• Display section under Worked Hours, this will show the day of the week for all punches:

• Display section under Worked Hours, this will show Total hours for each day:

• Warnings section, this will stop the popup from asking about rounding actual time each time to 
edit: 
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Reviewing Payroll in Time Clocks Plus 

• Settings section, this will enable the system to round for manually entered shifts:

How to Clock in and Out

There are 3 ways to clock in and out of TCP from any device within the office (Note that we have IP addresses 
and Geofencing set up)

1. From Prism- All employees can access Time Clock Plus from your prism portal log in, you will see Time Entry 
on the left menu, this takes you to a window to clock in /out.

2. From the appropriate direct link below, also on the employee resource page. Employees need a User ID 
which is their employee number. Managers can pull IDs from Prism for their employees. Employees will also 
need to use the last 4 digits of SSN as the password.

FG: https://306519.tcplusondemand.com/app/webclock/#/EmployeeLogOn/112-8164/8164
FF: https://306520.tcplusondemand.com/app/webclock/#/EmployeeLogOn/112-8166/8166

3. Using the app, see instructions below, download from the Apple or Play Store - TimeClock Plus v7 
MobileClock app ( note FF employees have other configurations)

• After downloading, it will need to be configured with these settings:

First Pacific Group
Scheme: https
Host: 306519.tcplusondemand.com
Port: 443
Namespace: 112-8164
Then the Employee ID from Prism
PIN: last 4 of SSN

• When clocking in on the App, you have to click Clock In, and then Continue on the next screen before 
you are actually clocked in, per screenshots below:
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Reviewing Payroll in Time Clocks Plus 
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Items to Note

• A punch showing in green means this is a Missed Punch that has already been given Manager 

Approval. Without the approval, it should show in a bolder blue.

• The rounding can only be applied to manually added segments and clocked in/out segments, not edited.  

Manually added segments are added through the Individual Hours feature by the manager.  Edited 

segments were originally recorded by the employee clocking in/out then a manager goes to Individual 

Hours to adjust the time in or out.

• Daily hours will not round correctly if an employee selects “Leave on Lunch” instead of “Clock Out” 

• If someone is unable to clock in from their phone while in the geofence, it may be due to their wifi so 

they should try the following troubleshooting steps to see if they are able to log in after any: 

1. Turn off wifi to disconnect, and then reconnect to wifi

2. Restart their phone

3. Have a manager or someone else try to clock in on their own phone at the same spot to see if it might 

be a phone or carrier-specific issue



Time Clocks Plus
Overtime Notes

• All OT log notes will be added as notes to the shift where any OT hours occurred in Time Clocks Plus. 
Basically, we just need you to add a note in TCP for any OT hours- so this would be for any day with over 
8 hours or call-outs that may become OT at the end of the week. The same info is required in this note 
as you would have put in the OT log- so unit/project for each overage. On any shift, you can click “Edit” 
to add a note in the highlighted area shown below.

• If you’re looking in Group hours you can see the notes that are showing in blue have data and you can 
click on any to see/edit/delete the note. 

7/29/2024 132



RingCentral App - Meetings

Follow these step-by-step instructions to join a meeting via 
the RingCentral app.
• Download the RingCentral App

• Log into your extension. 
• Click Join in the top left 
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RingCentral App - Meetings

• Enter Meeting ID then click Join.

• Once joined, select “Dial In” to connect audio.
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RingCentral App - Meetings

• Once in the meeting click the red “Start Video” icon on the 
bottom task bar to enable your camera. 
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Referrals are to be paid after the new resident who moved in has been 

living in their home for 30 days. 

The applicant MUST tell the leasing specialist on the initial call who 

referred them in order for the resident to get credit.

The referral credit is to be applied as a onetime concession to the 

referring resident’s account after these 30 days. 

This slip as well as CRM memo notes should be added to both accounts 

– please scan and save to resident file as an attachment. 

Resident Referral Credit

New Resident Name : 

Apartment :

Move-in Date :

Lease Term : 

Referring Resident :

Referring Unit :

Credit Entered by :

Amount :

*Referrals are to be paid after the new resident who moved in has been living in their home for 30 

days. The referral credit is to be applied as a onetime concession to the referring resident’s account 

after these 30 days. This slip as well as yard memo notes should be added to both accounts. 

Resident Referral Credit

01

02

03

04
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Resident Retention Program

Our number one goal is to keep our residents and it is up to us to make that happen!

Make sure to understand and follow this plan

Make it a priority to learn resident names and pet names

Always greet residents

Remember, we are, "At Your Service."

Prior to move in
Confirm utilities are in the resident's name, review all lease documents/key points/payment info

Move in day
Team member walks apartment prior to move-in with Sparkle Bucket and
leaves the gift with move-in booklet; Take move-in photos for their file.

Confirm payment in-full made with certified funds
Escort resident to their new home and indicate on map all community amenities

Hold mail keys until move-in checklist returned
Move-in follow up email (Auto Sent)

1 day after mi
VP Letter Emailed

7 days after mi
Follow up call on happiness with new home

14 days after mi
Maintenance Supervisor knocks on door to go over procedures

Follow-up Maintenance door hanger
Move-In Survey emailed (Auto Sent)

60 days after mi
Follow-up to deliver,"Have a Great Day,"door hanger

90 days after mi
Follow-up call/ SMS to check-in

During lease term
Ongoing communication, quarterly newsletter and resident events

120 days prior to renewal
Blank Service Request sent to resident 120 Day Email Auto-Sent

90 days prior to renewal
• Issue 90-day Renewal Proposal offer letter to be included on invitation with a small treat

• Email and post the offer to their door
• Send calendar invite for 30 days after notice served as offers will expire

After 30 days anyone that has not renewed is given an additional 7 days to sign or renewal or their proposal will be deleted and a new proposal at a great rate will be issued

80 days prior to renewal
Contact anyone that has not signed a renewal or given notice

70 – 60 days prior to renewal
If moving, NTV is now required

Contact anyone that has not renewed or given notice to remind them of 60- day notice
30 day notice required for SC & SS

If renewal or NTV is not signed, then email the list of whose proposals need to be deleted and regenerated

50 – 45 days prior to renewal
Send new offer letter

35 – 30 days prior to renewal
Send MTM reminder

20 – 14 – 10 days prior to renewal
Contact Resident to remind them they will be going MTM

After renewal
Thank You Email/ Survey Auto Sent

Carpet Voucher inside card signed by the team

After review
Send Thank You Card with Gift Card (Must be approved by Regional )
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Resident Retention Program

PRIOR TO MOVE IN

Confirm utilities are in the resident's name, review all lease documents/key 

points/payment info

• Team member walks apartment prior to move in with 
sparkle bucket 

• Leave move-in gift & move-in booklet

• Take move-in photos and upload to resident’s 
attachments in CRM

• Confirm payment in-full made with certified funds

• Escort resident to their new home and indicate on 
map all community amenities

• Hold mail keys until move-in checklist returned

• Move-in follow up email (Auto Sent

MOVE IN DAY

1 DAY AFTER MI

• VP Letter Emailed

7 DAYS AFTER MI

• Follow-up call on happiness with new home

14 DAYS AFTER MI

• Maintenance Supervisor knocks on door to go over procedures

• Follow-up Maintenance door hanger

• Move-In Survey emailed (Auto Sent)
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Resident Retention Program

60 DAYS AFTER MI

• Follow-up to deliver, "Have a Great Day,“ door hanger

90 DAYS AFTER MI

• Follow-up call / SMS to check-in

DURING LEASE TERM

• Ongoing communication, quarterly newsletter and resident events

120 DAYS PRIOR TO RENEWAL

• Blank Service Request sent to resident

• 120 Day Email Auto-Sent
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Resident Retention Program

90 DAYS PRIOR TO RENEWAL

• Issue 90-day Renewal Proposal offer letter to be included on invitation with a small treat

• Email and post the offer to their door

• Send calendar invite for 30 days after notice served as offers will expire

• After 30 days anyone that has not renewed is given an additional 7 days to sign or renewal 
or their proposal will be deleted and a new proposal at a great rate will be issued
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Resident Retention Program

80 DAYS PRIOR TO RENEWAL

70 DAYS PRIOR TO RENEWAL

60 DAYS PRIOR TO RENEWAL

50 DAYS PRIOR TO RENEWAL

45 DAYS PRIOR TO RENEWAL

35 DAYS PRIOR TO RENEWAL

30 DAYS PRIOR TO RENEWAL

20 DAYS PRIOR TO RENEWAL

15 DAYS PRIOR TO RENEWAL

10 DAYS PRIOR TO RENEWAL

Contact anyone that has not signed a renewal or given notice

Send 15 Day offer Expiring Letter

• if moving, NTV is now required
• Contact anyone that has not renewed or given notice to remind 

them of 60- day notice
• 30 day notice required for SC & SS

• If renewal or NTV is not signed, then email the list of whose proposals need 
to be deleted and regenerated

Send new offer letter

45-Day reminder email will auto-send to the resident encouraging them to 
renew if they haven’t already done so 

Follow up call to resident to remind them of the Month-to-Month fees and notice 
requirements & encourage them to renew or determine any concerns they have

Follow up call to remind them to renew to avoid month-to-month fees.

Contact Resident to remind them they will be going MTM

Follow up call & visit the resident’s home between 5 & 6pm if they have not signed to remind 
them to renew ASAP to avoid month-to-month fees.

Send MTM Reminder
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Resident Retention Program

AFTER RENEWAL

• After Renewal Thank You Email/Survey Auto Sent

• Carpet Voucher inside card signed by the team

• Upon renewal each home is given a carpet cleaning coupon – good for one free carpet cleaning within 60 

days of receipt

• The resident then contacts our carpet cleaning vendor directly to schedule the cleaning themselves 

• At the time the cleaning is done the resident should present the voucher to the vendor for payment or 

leave in plain site in the apartment for the vendor if they aren’t home

• The vendor should then take the voucher and staple it to the invoice as they submit it for payment

• Once the invoice is received, the voucher is scanned and attached to the resident profile 

• Check ‘No’ on the chargeback stamp and note “Renewal” on the notes line 
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Resident Retention Program

AFTER APARTMENT RATING REVIEW

Send a personal thank you card with a gift card once approved by the regional manager.



Renewal Report

The renewal report should be used for generating monthly renewal tracking logs and will also serve as 
the renewal commission log once all renewals are finalized. 

To generate the report in Voyager from the left-hand menu:

Residential -> Workflow -> Lease Expiration Report

Enter Filters: Example - Renewal Log for May 2020 Lease Expirations

• Property
• Lease From Date = First Day of the Month (05/01/2020)
• Lease To Date = Last Day of the Month (05/31/2020)
• Output Type = Excel

Click View Report

Open the attachment and save as: Property Code Renewal Log Date (HC Renewal Log 11-26-19) and 
save to the server in the corresponding month folder.

D:\Data\SITE SERVER\SC SITE\Lease Documents\HC\Renewals\_Renewal Log\2020\05-2020



• The Renewal Report will pull resident current info

• Renewal rates will be set per your current policy. Once new rates are set proposals need to be 
created for each in order for the letters to generate properly. Follow current policy for creating 
proposals. Once created and approved the team will initial the cells in each column as the tracking 
items are completed. 

• Once the all renewals are finalized you will add the commission for the renewal to the commission 
column and total all commissions at the bottom and note the split per team member. 

• Once finished save as “Property Code Renewal Commissions Date” (HC Renewal Commissions 11-26-
19) and save to commissions folder on the server. 

Renewal Report



Sex Offender Websites

Missouri
Website: 
http://www.mshp.dps.mo.
gov/MSHPWeb/PatrolDivisi
ons/CRID/SOR/SORPage.ht
ml
Click I agree:

Click search map offenders:

On the interactive map 
search on the right side 
input the property 
address, select the 
distance for the desired 
search, and click find 
address:
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Sex Offender Websites

A map and list will 
populate with the 
locations and names of 
sex offenders living and 
working within the 
searched radius:

Click the buttons to navigate, 
save, or print the map. 
New Mexico
Website: 
http://sheriffalerts.com/cap_offic
e_disclaimer.php?office=55290&f
wd=aHR0cDovL2NvbW11
bml0eW5vdGlmaWNhdGlvbi5jb2
0vY2FwX21haW4ucGhwP29mZml
jZT01NTI5MA==
Check I agree to the above terms 
& conditions and click continue:

Click search offenders in your 
area:
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Sex Offender Websites

On the in your area tab 
input the property address 
and click search:

A map and list will populate with 
the locations and names of sex 
offenders living and working within 
a one mile radius. 
Use the radius drop down menu to 
charge the area searched:

Michigan
Website: 
http://www.mipsor.state.mi.us/
Enter the code shown where 
specified at the bottom of the 
page and click I have read and 
agree to the terms:
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Sex Offender Websites

Click search within 1 mile radius:

Input the property address and click submit:

A map will populate with the locations of sex offenders living within a one mile radius:
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Sex Offender Websites

Hover over the blue and red address 
icons and a list of sex offenders at 
that address will appear:

Ohio
Website: 
http://sheriffalerts.com/cap_main.php?off
ice=55149
Click search for offenders in your area:

On the in your area tab input 
the property address, check all 
boxes for offender address 
type, and click search:
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Sex Offender Websites

A map and list will populate with the locations and names of sex 
offenders living and working within a half mile radius. 

Use the radius drop down menu to charge the area searched:
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Sorting In Excel
Many reports used daily or weekly are pulled from Yardi and can be exported to excel. The information 

in these reposts can then be manipulated to make the contents more user friendly. The easiest way to 
manipulate the information into a more visually appealing way is to sort it. Sorting is an easy way to make the 
data appear by which ever grouping you need. Such as by last name, unit number, charge code, date, etc. To 
sort you simply: 

• 1. Open in Excel

• 2. Highlight all and click MERGE & CENTER to unmerge all cells

• 3. Click on row 8 (the row above all info) then click the Data tab, and then click Filter

• 4. Click on the arrow at the top of the column you want to sort by (so column C to sort by unit) and 
chose sort A-Z
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Check Scan Procedures
Scan Check Deposits into Chase using the new Panini ML: Deal Check Scanner

Log in to your Chase Account

Click “Collect & Deposit”
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On the “Deposit Checks” tab, enter your Deposit to account, Deposit total, click 
Next



Check Scan Procedures
Scan check. Face side up, with routing/account numbers on the right side. 

Confirm all numbers are correct, and click Next
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Click Send deposit
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Google Drive Folders

-Home shows you files that Drive thinks you'll want to use. This is based on various 

criteria like when you edit them, open them, uploaded them, when they were shared 

with you, or documents attached to upcoming Calendar events. You can generally 

ignore this folder.

-My Drive contains files and folders that you created outside of the Shared drive and 

you control access to. You are able to share access and permissions to these files and 

only the files you share from your My Drive will be accessible to others. To share files 

located in My Drive, right click on the file…

-Shared Drive is the primary folder in Google Drive that First Pacific uses to store and 

collaborate on files. Unlike in My Drive, Shared Drive and its contents are managed by 

the company, though employees have access to their property’s files. Permission for 

these files include view only or write permissions. Within a single folder you may only 

have view access for a top level folder but then have write access as you drill down the 

folder hierarchy. Please notify your manager if you’re unable to access a file you 

believe you should have access to. Once you are a member of a Shared Drive, the 

drive will appear below your “My Drive” and above “Shared with me” in your Google 

Drive in the sidebar.

-Shared with me is very different from Shared Drive. Shared with me generally are 

files that you only have access to because an individual shared them with you. The 

owner of those files has full control and can revoke access at any point. When 

someone shares a file from their “My Drive”, it goes into the “Shared with me” section 

for whoever they are sharing with. You can create a shortcut of a file in Shared with 

me and move the shortcut to your My Drive or just leave it in Shared with me. Files in 

your Shared Drive will NOT also show up Shared with me.
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Google Drive File Collaboration / 

Find Files

Google Drive File Collaboration

•All file changes are automatically saved in real time so no need to save as you go.

•Permissions for a file can be edit, comment, or view so you can do certain things 

based on your permission.

•With Google Drive, version control isn’t a problem. Generally, no more need for saving 

multiple versions of a file, except when doing so for specific reasons.

•Collaborating on a file now is a breeze. All of your coworkers can work on the same 

document, at the same time. You can always see in the upper right corner if someone 

else is working on the file.

Finding Files

•Google is known for its search engine so the easiest way to find a file is just to type 

the name of the file in the search bar, or any word in the name. If you want a more 

refined search, click the Advanced Search icon on the right side of the search 

bar. This lets you search within a specific folder or using other specific criteria.

•Or, you can search manually by clicking through the folder hierarchy. You can see the 

folder structure in the left panel and in the main body.

•You can see the full breadcrumb list on the left by clicking the down arrows or double 

clicking the folder name to expand/collapse each folder. Note that individual files 

never show on the left panel, only in the main body.

•The breadcrumb list at the top of the main body only shows 2 or 3 folders so you need 

to click the horizontal ellipses to see the full path.
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Organizing Shared Drive Files for easier

access

Organizing Shared Drive files for easier access

•You cannot move a file or folder out of Shared Drive into My Drive so to 

put something into another location outside of Shared Drive you need to 

create a shortcut to the original file. Right click on a file, select organize, 

select add shortcut, then select where you want the shortcut to 

go. Importantly, if you delete a shortcut it does NOT delete the original 

file. Also, you’ll get a message that moving a file from one folder to 

another will lose the original permissioning and take on the permissioning

of the destination folder.

•Starred: Helpful for starring favorite files/folders for easier access. You 

can’t create your own folder structure like in My Drive so this is just a flat 

list of favorites. This simply saves a link to the original file itself. To 

remove an item from your starred list, right click the item, click organize, 

then click remove from starred. This only removes it from your starred list, 

it doesn’t delete the original file.

•My Drive: Helpful for creating a file hierarchy for documents that are not 

shared with the team. For example, storing files/folders from the Shared 

Drive that you want easier access to. Remember that only shortcuts to 

Shared Drive files/folders can be placed here, not the original files/folders 

themselves.
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Download Report From Yardi and Open/Save in Google Drive

•Download report from Yardi and save into Download folder on computer 

(or any location you choose to put it).

•If you want to save in the Shared Folder in Google Drive, navigate to the 

destination folder in Google Drive. In upper left corner click the “+ New” 

button, select “file upload”, navigate to wherever you saved the file and 

double click the file.

•If you only want to open the file and NOT save it in the Shared Folder, 

follow the same steps as above but navigate/upload to your My Drive 

folder instead of the Shared Drive folder as the destination.

Create a New Version (Copy) of a Google Document/Spreadsheet

•Right click on the file you want to save as a new version. Or click on the 

ellipses to the right of the file name. Select, “Make a copy”. Rename the 

copied file.

•Note: Make sure to create the new copy BEFORE you make any 

changes to the file since all changes are automatically saved in real time.

Share a Google Drive Document

•Right click the document, or click the vertical ellipses next to the 

document.

•Click “Share”

•Type the email of the person you’re sharing with. Assign 

viewer/commenter/editor permissions.

•Click Done.

•Note that documents in the Shared Drives can’t be shared outside of First 

Pacific.

Page|163



Page|164

Google Drive How-To’s

Page|164

Email a Google Drive Document

•Create a new email in Gmail

•At the bottom of the email click the icon   

•Select whether you want to send as a link or an attachment in the bottom 

right corner of the page

•It’s recommended to first share/permission the document with the recipient 

in Google Drive before sending a Google Drive link.

Manage PDF’s in Google Drive

•You must have an Adobe Acrobat license before being able to manage/edit 

PDF’s in Google Drive. Contact your manager if you need a license.

•Once you have an Adobe Acrobat license, you need to connect your license 

to your Google Drive account by following the steps below:

• Open Google Drive and click My Drive (the one right beneath the 

search bar)

• Click More

• Click Connect more apps

• Click Search apps and type Adobe Acrobat

• Click Adobe Acrobat and then Install

• Click Continue and sign in with your Google account

• Scroll down and click Continue

• Click OK

• You'll know it worked when you go to any pdf in Google Drive, right 

click on it, click "open with", and you should see Adobe Acrobat 

listed as one of the options.
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Google Drive Tips/Tricks

•All documents/spreadsheets are collaborative, meaning 

multiple people can work on the same 

document/spreadsheet at the same time.

•You can see if someone else is in the 

document/spreadsheet by looking for a small thumbnail 

image in the upper right corner of the page.

•Remember to close documents when you’re done working 

on them.

•Avoid having lots of documents/tabs open at the same 

time.

•If your internet speed seems slow and lagging, try running 

an internet speed test using this 

link: https://fiber.google.com/speedtest/.

•If you are creating a new version of a document, make 

sure to “create a copy” before you make any changes to 

the document.

•If you need assistance with anything related to Google 

Drive, please contact Adam at ameyers@fpacific.com.



Please notify Haley Cornish at 
hcornish@fpacific.com with any 

content changes or updates. 

7/29/2024 166


